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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the Safety
Information in the "General Settings Guide" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Warning
Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.
AppleTalk, Apple, Macintosh and Mac OS are registered trademarks of Apple Computer, Incorporated.
IPS-PRINT™ Printer Language Emulation Copyright® 2000, Oak Technology, Inc., All Rights Reserved.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

Bluetooth® is a registered trademark of Bluetooth-SIG Inc. worldwide.
Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
The proper names of the Windows operating systems are as follows:
*  The product name of Windows® 95 is Microsoft® Windows® 95
* The product name of Windows® 98 is Microsoft® Windows® 98
* The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)
» The product name of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server
* The product name of Windows® XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional
e The product names of Windows Server™ 2003 are as follows:

Microsoft® Windows Server™ 2003 Standard Edition

Microsoft® Windows Server™ 2003 Enterprise Edition

Microsoft® Windows Server™ 2003 Web Edition
» The product name of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0

Notes
Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Machine

The following manuals describe the operational procedures of this machine. For
particular functions, see the relevant parts of the manual.

& Note
O Manuals provided are specific to machine type.

O Adobe Acrobat Reader/Adobe Reader is necessary to view the manuals as a
PDF file.

O Two CD-ROMs are provided:
¢ CD-ROM 1“Operating Instructions”
¢ CD-ROM 2“Scanner Driver and Document Management Utility”

« General Settings Guide
Provides an overview of the machine and describes System Settings(such as
Tray Paper Settings), Document Server functions and troubleshooting.
Refer to this manual for Address Book procedures such as registering fax
numbers, e-mail addresses, and user codes.

< Security Reference
This manual is for administrators of this machine. It describes security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use. Also refer to this manual for the
procedures for registering administrators, as well as setting user and admin-
istrator authentication.

< Network Guide (PDF file - CD-ROM1)
Provides information about configuring and operating the printer in a net-
work environment or using software. This manual covers all models, and
therefore contains functions and settings that may not be available for your
model.
Images, illustrations, functions, and supported operating systems may differ
from those of your model.

< Copy Reference
Describes operations, functions, and troubleshooting for the machine’s copier
function.

« Facsimile Reference <Basic Features>
Describes operations, functions, and troubleshooting for the machine's fac-
simile function.

« Facsimile Reference <Advanced Features>
Describes advanced facsimile functions such as line settings and procedures
for registering IDs.

< Printer Reference (this manual)
Describes system settings, operations, functions, and troubleshooting for the
machine’s printer function.



< Scanner Reference (PDF file - CD-ROM1)
Describes operations, functions, and troubleshooting for the machine’s scan-
ner function.

< Manuals for DeskTopBinder Lite

DeskTopBinder Lite is a utility included on the CD-ROM labeled “Scanner

Driver and Document Management Utility”.

* DeskTopBinder Lite Setup Guide (PDF file - CD-ROM2)
Describes installation of, and the operating environment for DeskTop-
Binder Lite in detail. This guide can be displayed from the [Setup] dialog
box when DeskTopBinder Lite is installed.

¢ DeskTopBinder Introduction Guide (PDF file - CD-ROM?2)
Describes operations of DeskTopBinder Lite and provides an overview of
its functions. This guide is added to the [Start] menu when DeskTopBinder
Lite is installed.

e Auto Document Link Guide (PDF file - CD-ROM2)
Describes operations and functions of Auto Document Link installed with
DeskTopBinder Lite. This guide is added to the [Start] menu when Desk-
TopBinder Lite is installed.

« Other manuals

¢ PostScript 3 Supplement (PDF file - CD-ROM1)

¢ UNIX Supplement (available from an authorized dealer, or as a PDF file on
our Web site)



How to Read This Manual

Symbols

In this manual, the following symbols are used:

N\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

A\ CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions are
not followed, may result in minor or moderate injury, or damage to property.

* The statements above are notes for your safety.

#Important
If this instruction is not followed, paper might misfeed, originals might be dam-
aged, or data might be lost. Be sure to read this.

ﬁ Preparation
This symbol indicates prior knowledge or preparation is required before opera-
tion.

& Note

This symbol indicates precautions for operation, or actions to take after mal-op-
eration.

® Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

AP Reference
This symbol indicates a reference.

[ ]

Keys and buttons that appear on the computer's display.
Keys that appear on the machine's display panel.

(1

Keys built into the machine's control panel.

Keys on the computer's keyboard.






Control Panel
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1. Indicators

Displays errors and machine status.
1&J: Add Staples indicator

L&: Add Toner indicator

&: Load Paper indicator

1: Service Call indicator

[#: Open Cover indicator

8: Misfeed indicator

See "Control Panel", General Settings
Guide.

2. [User Tools/Counter] key

e User Tools
Press to change default settings and
conditions to your requirements.

¢ Counter
Press to display or print the total
number of copies made.

3. Display panel
Displays operation status, error messag-

es, and function menus. See p.7 “Display
Panel”.

4. [Energy Saver] key

Press to switch to and from Energy Saver
Mode.

& Note

O This key is ineffective during System
Settings (User Tools) operations.

5. Main power indicator

This indicator lights when the main pow-
er switch is turned on.

iﬁklmportant
O Do not turn off the main power
switch while the On indicator is lit

or blinking. Doing so may damage
the hard disk.

6. On indicator

This indicator lights when the operation
switch is turned on.

7. Operation switch

Press this switch to turn the power on
(the On indicator goes on). To turn the
power off, press this switch again (the On
indicator goes off).



Getting Started

8. [Clear/Stop] key

Press to cancel the entered data.
9. [#]) key

Press after entering a value.

10. Number keys

Press to enter a value for various settings.

11. Function keys

Press to switch between the “Copy”,
“Document Server”, “Fax”, Printer”, and
“Scanner” screens.

The indicator for the selected function
lights.

12. Function status indicators

These show the status of the above func-
tions:

e Green: the function is active.

* Red: the function has been interrupted.
13. ©: Data In indicator

The Data In indicator shows the status of
data reception from a computer.

e This indicator blinks when data is be-
ing received.

e This indicator lights when there is
data remaining to be printed.



Control Panel

Display Panel

This section describes configuration using the display panel when the printer

function is selected.

ﬂlmportant

O The machine switches to offline when you make settings when the machine
is online. After you complete the setting, the machine switches to online au-

tomatically.

O If you make a setting when the machine is offline, it will stay offline after-

ward.

O The function items displayed serve as selector keys. You can select or specify

an item by pressing it lightly.

O When you select or specify an item on the display panel, it becomes highlighted.

O Keys dimmed (for example,

) cannot be used.

2 —] L rrpeyas 1@ Dl20 O[36 O[aW O & 1|

1 Ad | Ad | A3 | A3 |cmsie 8
3 _ | b Lists & EnorLog
4 (| [ Locked 4 Sample Print Job Lt | | EmorLog 11 Sexcing ot L ]

: | |

1. Operational status or messages
Displays current machine status, such as
"Ready"”, "Offline", and "Printing...". In-
formation about the print job (user ID
and document name) appears in this sec-
tion.

2. [ Online] key / [k#Offline] key
When you press these keys, the machine
switches between online and offline.
When the machine is online, it can re-
ceive data from the computer.

When the machine is offline, it cannot re-
ceive data from the computer.

AEU039S

3. [Form Feed] key

Press to print all the data left in the ma-
chine's input buffer.

& Note

O When the machine is online, the status
appears dimly.

O This function is not available with the
RPCS printer language.

4. [Job Reset] key

Press to cancel the current print job.

If you press it when the machine is offline

and Hex Dump is selected, Hex Dump is
canceled.



Getting Started

5. [Locked & Sample Print Job List]

Press to display Locked/Sample Print
jobs sent from a computer.

6. [Error Log]

Press to display the error logs, such as
Locked/Sample Print jobs sent from a
computer.

& Note

7. [Spooling Job List]
Press to display spooled jobs.

8. [»Paper Tray Status] key
The paper tray settings appear.

O When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “User Tools (System Set-

tings)”, General Settings Guide.



User Authentication

User Authentication

When user authentication (User Code
Authentication, Basic Authentication,
Windows Authentication, or LDAP
Authentication) is set, the authentica-
tion screen is displayed. Unless a val-
id user name and password are
entered, operations are not possible
with the machine. Log on to operate
the machine, and log off when you
are finished operations. Be sure to log
off to prevent unauthorized users
from using the machine.

& Note

O Consult the User Administrator
about your login user name, pass-
word, and user code. For details
about the various types of user au-
thentication, consult the appropri-
ate administrators.

O For user code authentication, enter
a number that is registered in the
Address Book as a login user name
as the user code.

User Code Authentication
(Using the Control Panel)

When user authentication is set, the
following screen appears.

Enter a user code (eight digit), and
then press [#].

User Code Authentication
(Using a Printer Driver)

When user authentication is set, spec-
ify the user code in the printer prop-
erties of a printer driver. For details,
see the printer driver Help.

Login (Using the Control Panel)

Follow the procedure below to log in
when Basic Authentication, Windows
Authentication, or LDAP Authentica-
tion is set.

l] Press [Enter] for [Login User Name].

g Enter a login user name, and then
press [OK].

B Press [Enter] for [Login Password].

ﬂ Enter a login password, and then
press [OK].

B Press [Login].
When the user is authenticated, the

screen for the function you are us-
ing appears.




10

Getting Started

Logoff (Using the Control Panel)

Follow the procedure below to log off
when Basic Authentication, Windows
Authentication, or LDAP Authentica-
tion is set.

l] Press [User Tools/Counter] key.

ﬂ Press [— Logout].
[ User Tools / Gounter /inquiry NN | NSREEN |
, |e_“ e e |
sytensatigs
@ s
[ e | [B e | [1 ]
[6 wmram | [@  om |
B Press [Yes].

ﬂ Press [User Tools/Counter] key.

Login (Using a Printer Driver)

When Basic Authentication, Win-
dows Authentication, or LDAP Au-
thentication is set, make encryption
settings in the printer properties of a
printer driver, and then specify a
login user name and password. For
details, see the printer driver Help.

& Note

O When logged on using a printer
driver, logging off is not required.



Connecting the Machine

Connecting the Machine

pe Reference
For information about connection
using Ethernet and wireless LAN,

see "Confirming the Connection",
Network Guide.

For information about connection
using Bluetooth, see the manual
that comes with the optional Blue-
tooth interface unit.

Requirements

Before using this machine, make sure
all environmental and electrical re-
quirements are met. Connect the ma-
chine to the host computer using the
parallel port, network interface unit,
or both.

Make sure all cables, connectors, and
electrical outlets necessary to attach
the machine to the host computer or
network are at hand.

Connecting the machine to the
host using a USB cable

You can connect the machine to the
host computer using a USB interface
cable.

This machine does not come with a
USB interface cable. Make sure you
purchase the appropriate cable for the
machine and your computer.

Follow the procedure below to con-
nect the machine to the host computer
using a USB interface cable.

ﬂ Connect the USB 2.0 interface ca-
ble to the USB port on the right
side of the machine.

\‘sﬁ<l

N——n
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ﬂ Connect the other end to the USB
port on the host computer.

& Note

O The USB 2.0 interface board is
supported by Windows 98
SE/Me/2000/XP, Windows
Server 2003, Mac OS X v10.3 or
higher.

¢ For Windows 98 SE/Me:
Make sure to install “USB
Printing Support”. If USB 2.0
is used with Windows 98
SE/Me, only a speed equal to
that of USB 1.1 is possible.

¢ For Mac OS:
Mac OS supports only the
standard USB port. If USB 2.0
is used with a Mac OS, only a
speed equal to that of USB 1.1
is possible.

11
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Connecting the Machine to the
host using the parallel cable/IEEE
1394 (SCSI print) cable

Connect the machine to the host com-
puter using the optional parallel
board or optional IEEE 1394 interface
board. This machine does not come
with a parallel cable to connect the
machine to the host computer.

The machine's parallel interface is a
standard bidirectional interface. It re-
quires a standard IEEE 1284 compli-
ant 36-pin parallel cable and a parallel
port on the host computer. Make sure
you purchase the appropriate cable
for the machine and your computer.

& Note

O Do not use a parallel cable that is
longer than 3 meters (10 feet).

O Rating voltage of the interface con-
nector: Max. DC 5V

Follow the procedure below to con-
nect the machine to the host computer
using a parallel cable or IEEE 1394 in-
terface cable.

#Important

O Before connecting the machine and
a computer using an interface ca-
ble, make sure the machine is not
operating, and then turn off the
main power switches of the ma-
chine and computer.

O Be sure to use a specified interface
cable. Other cables may cause ra-
dio interference.

ﬂ Turn off the main power switches
of the machine and computer.

ﬂlmportant

O Before turning off the main pow-
er switch, see “Turning Off the
Power”, General Settings Guide.

a Plug the cable into the connector
on the machine’s interface.

< Parallel Connection

AEU002S

< IEEE 1394 (SCSI print) Connection

AEU003S

BPlug the other end of the cable
into the connector on the compu-
ter’s interface.

ﬂ Turn on the machine's main pow-
er switch.



Connecting the Machine

B Turn on the computer.

& Note

O When using Windows 95/98/
Me/2000/XP and Windows
Server 2003, a printer driver in-
stallation screen might appear
when the computer is turned
on. If this happens, click [Cancel]
on the screen. For more infor-
mation, see p.19 “Preparing the
Machine”.

The machine and computer are
now connected. The printer driver
must be installed next. For infor-
mation about how to install the
printer driver, see p.19 “Preparing
the Machine”.

Connecting to the Ethernet
Interface

The network interface board supports
10 BASE-T or 100 BASE-TX connec-
tions.

i@klmportant

O Before making the connection, touch
the metallic part to ground yourself.

nA core for the Ethernet cable is
supplied with this machine. The
Ethernet cable loop should be
about 15 cm (6 in.) () from the
machine end of the cable.

AEV047S

ﬂ Turn off the main power switch.

ﬂlmportant

O Make sure the main power is
off. See "Turning On the Pow-
er", General Settings Guide.

B Connect the Ethernet cable to the
10 BASE-T / 100 BASE-TX port.

L“:%' (D) T
B L |
A ] 1%
[W)

aeRl
dlal |

AEU040S

ﬂ Turn on the main power switch.

[

1. Indicator (green)
Remains green when the machine is
properly connected to the network.

ZKRHOS0E

2. Indicator (yellow)
Turns yellow when 100 BASE-TX is
operating. Turns off when 10 BASE-T
is operating.

13
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Setting Paper on the Bypass Tray

This section gives instructions for set-
ting paper on the bypass tray. Use the
bypass tray to print onto OHP trans-
parencies, labels, thick paper, and en-
velopes that cannot be loaded in the
paper tray.
AP Reference
For details about setting paper in
the regular paper tray, see General
Settings Guide.

& Note

O When loading letterhead paper,
pay attention to its orientation. See
“Orientation-Fixed Paper or Two-
Sided Paper”, General Settings
Guide.

O Paper within the following dimen-
sions can be set in the bypass tray:

e Vertical: 90 - 305 mm (3.6 - 12.1in.)

e Horizontal: 148 - 600 mm (5.9 -
23.7 in.)

O Be sure to set the paper with the
side you want to print facing down
in the bypass tray.

O When loading OHP transparencies
or thick paper in the bypass tray,
make the paper setting using the
control panel or printer driver.

O The number of sheets that can be
loaded in the bypass tray depends
on the paper type.

O Paper sizes fed from the bypass
tray are output first sheet down,
print side-up.

? Limitation

O The following functions are disa-
bled when printing from the by-
pass tray:

¢ Duplex printing
¢ Auto Tray Select
e Auto Tray Switching
¢ Rotating Collate

* Staple (When the optional unit is
installed)

* Punch (when the optional unit
is installed)

{important

O When printing using the printer
function, original images are al-
ways rotated by 180 degrees (the
orientation of images to be printed
is opposite to that of the copier
function). When printing onto pa-
per with specific orientation re-
quirements, such as envelopes and
letterheads, make sure to rotate the
paper feed orientation to 180 de-
grees.

O Be sure to set the paper size using
the printer driver when printing
data from the computer. The paper
size set using the printer driver has
priority over the one set using the
display panel.

ﬂ Open the bypass tray.

7/

AEU004S



Setting Paper on the Bypass Tray

ﬂ Adjust the paper guides to the pa-
per size.

#Important

O

If the paper guides are not flush
against the paper, skewing and
misfeeds might occur.

B Gently insert paper face up into
the bypass tray until the beeper
sounds.

AEUO11S

1. Extender

2. Paper guides
& Note

O

O

The beeper will not sound if it is
turned off. Gently insert paper
until it stops.

Do not stack paper over the lim-
it mark, otherwise a skewed im-
age or misfeeds might occur.
Open out the extender to support
paper sizes larger than A4 [J,
81/,"x11" 7.

Fan the paper to get air between
the sheets to avoid a multi-sheet
feed.

When setting an OHP transpar-
ency, make sure that its front
and back sides are properly po-
sitioned.

Select paper type when printing
onto OHP transparencies or thick
paper (over 127.9 g/m?). For de-
tails, see p.17 “Setting thick pa-
per or OHP transparencies”.

ﬂ Select the paper size.

& Note

O You can set paper size using the
printer driver. The following
procedures are not necessary
when setting paper size using
the printer driver.

O The paper size set using the
printer driver has priority over
that set using the display panel.

O When the printer driver is not
used, make settings using the
display panel.

O Thick paper and OHP transpar-
encies are delivered face up on
the top of the preceding page;
therefore, the prints need to be
rearranged into the correct or-
der. To avoid this, select [Reverse
order print] in the RPCS printer
driver settings to deliver the
prints in the correct page order.

/O Reference
For printer driver settings, see
the printer driver Help.

For details about setting custom
sizes, see p.16 “Setting custom
size paper”.

@ Press the [User Tools/Counter)
key on the control panel.

| &/= | ] ==

9 N wuwwy
Screen i
Contrast Eifecewe (1 i [ &

AEU035S

)

@ Press [System Settings].
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Getting Started

© Press the [Tray Paper Settings] tab.

System Settings
St v ot Dlovig st

Gl s | TP st |_Timer sy e setons
[Pty com 1 | Trramom Ty s vet ]

[ P rayriony ramie ot 1 e s oo ]

T T | trrom tays oo ]

v [T

@ Press [VNext] to scroll through
the list.

@ Press [Printer Bypass Paper Size].

0 Select the paper size.

& Note

O Press [APrevious] or [VNext]
to scroll through the list.

O When printing onto thick pa-
per or OHP transparencies,
select paper type. For details,
see p.17 “Setting thick paper
or OHP transparencies”.

@ Press [OK].

© Press the [User Tools/Counter]
key.

Setting custom size paper

& Note

O Custom sizes can also be set using
the printer driver. The following
procedures are not necessary
when setting custom sizes using
the printer driver.

O Custom size settings set using the
printer driver have priority over
those set using the machine's dis-
play panel.

O When the printer driver is not
used, make settings using the dis-
play panel.

/O Reference

For printer driver settings, see the
printer driver Help.

l] Press the [User Tools/Counter] key
on the control panel.

a Press [System Settings].
B Press the [Tray Paper Settings] tab.

ﬂ Press [VNext] to scroll through the
list.

B Press [Printer Bypass Paper Size].
E Press [Custom Size].

If a custom size is already set, press
[Change Size] .
ﬂ Press [Vertical].

B Enter the vertical size of the paper
using the number keys, and then
press [#].

;

< 3003050

R —

805000

ﬂ Press [Horizontal].

[[ﬂ Enter the horizontal size of the
paper using the number keys, and
then press [#].

{8 press [oK].

The paper sizes entered are dis-
played.

m Press [OK].
[E] Press the [User Tools/Counter] key.



Setting Paper on the Bypass Tray

Setting thick paper or OHP
transparencies

& Note

O Paper settings can also be set using
the printer driver. The following
procedures are not necessary
when setting paper sizes using the
printer driver.

O Paper size settings set using the
printer driver have priority over
those set using the machine's dis-
play panel.

O When the printer driver is not
used, make settings using the dis-
play panel.

/O Reference

For printer driver settings, see the
printer driver Help.

l] Press the [User Tools/Counter] key
on the control panel.

ﬂ Press [System Settings].
ﬂ Press the [Tray Paper Settings] tab.

ﬂ Press [VNext] to scroll through the
list.

B Press [Paper Type: Bypass tray].

System Settings
Somc ot f e lovig ket
(Lot restms | Ty Setogs |_Timrstings ) oro s | T it s

T ) ]
i ey [y zomtcon araesoion |
i twt o oy amorsmieton |
e Tagt oy owacny morgmieton |
P Tyt oy swetmy morgeieon | o0 [ X |[ ]

(3 scicct [OHP] o [Thick Paper]

ﬂ Press [OK].

The paper type selected is dis-
played.

ﬂ Press the [User Tools/Counter] key.

& Note

O The settings made will remain
valid until they are reset again.
After printing on OHP trans-
parencies or thick paper, make
sure to clear settings for the next
user.
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e
2. Preparing the Machine

Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 us-
ers can easily install this software using the CD-ROM provided.

Using Quick Install, the PCL printer driver and/or RPCS printer driver and
SmartDeviceMonitor for Client is installed under network environment, and
TCP/IP port will be set.

#Important

O To install printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

O The Quick Install is not available when using this printer under USB connec-
tion. If you connect using USB, refer to p.43 “Installing the Printer Driver Us-
ing USB”.

n Quit all applications currently running.
g Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

B After reading the agreement, click [l accept the agreement] , and then click
[Next >].

E Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

O ciicx [Install].
The printer driver installation starts.

19
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Preparing the Machine

B click [Finish]

A message about restarting the computer may appear. Restart the computer
to complete installation.

ﬂ Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

A Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.60 “If
Bidirectional Communication is Disabled” for details about bidirectional
communication between machine and computer.



Confirming the Connection Method

Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using this machine as the Windows printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
1IEEE 1394 (IP over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client
-TCP/P -TCP/IP -TCP/IP -TCP/IP
-NetBEUI -NetBEUI -IPP -NetBEUI
<. -IPP <. -IPP <~ Standard TCP/IP <. -IPP
@I @I Standard TCP/IP @I LPR @I LPR
Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

27720048

< Windows 95/98

Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port
IEEE 1394 (IP over 1394) None

< Windows Me
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port
IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

21



Preparing the Machine

< Windows 2000
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port
IEEE 1394 (IP over 1394) None
< Windows XP
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP
LPR port

IEEE 1394 (IP over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

< Windows Server 2003
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP
LPR port

IEEE 1394 (IP over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

< Windows NT 4.0
Connection Method Available Ports
Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

LPR port

IEEE 1394 (IP over 1394)

None

/O Reference

See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.25 “Using the SmartDe-
viceMonitor for Client Port”.

For the Standard TCP/IP port, see p.34 “Using the Standard TCP/IP Port”.
For the LPR port, see p.36 “Using the LPR Port”.



Confirming the Connection Method

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0 NetWare NetWare
Print Server Print Server File Server
Ny & S
NNj) D NN}
S A A

Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

2220038

/O Reference

See the explanation of how to install the printer driver for each type of net-
work printer.

For the Windows network printer, see p.38 “Using as the Windows Network
Printer”.

For the NetWare print server and remote printer, see p.40 “Using as the Net-
Ware Print Server/Remote Printer”.
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Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection methods.

Windows 95:

e Parallel connections

Windows 98:

e Parallel and Bluetooth connections

Windows 98 SE/Me:

e USB, Parallel, and Bluetooth connections

Windows 2000:

e USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
Windows XP:

e USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
Windows Server 2003:

e USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections
Windows NT 4.0:

e Parallel and Bluetooth connections

/o Reference

See the explanation of how to install the printer driver for each method of
connection.

For the USB connection, see p.43 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.48 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.50 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.54 “Printing with Bluetooth Connec-
tion”.



Using the SmartDeviceMonitor for Client Port

Using the SmartDeviceMonitor for Client Port

Installing SmartDeviceMonitor for Client

#Important

3 To install SmartDeviceMonitor for Client under Windows 2000/ XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
ﬂ Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [SmartDeviceMonitor for Client/Admin].
B The SmartDeviceMonitor for Client installer starts.

E The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [l accept the agreement], and
then click [Next >].

ﬂ Click [SmartDeviceMonitor for Client], and then click [Next >].
The SmartDeviceMonitor for Client installer starts.

ﬂ Follow the instructions on the display to install SmartDeviceMonitor for
Client.

g Click [Finish].

If you are required to restart the computer after installing SmartDeviceMon-
itor for Client, restart the computer.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.
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Installing the PCL or RPCS Printer Driver (TCP/IP)

#Important

O To install this printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

& Note
O The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

B) Glick [Port:], and then click [Add].
[[!] Click [SmartDeviceMonitor], and then click [New Port...].

ﬂ] Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.



Using the SmartDeviceMonitor for Client Port

m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

Under Windows 95/98/Me, you cannot add an IP address partially similar to
the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx”

cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be
used.

iB Check that the port of the selected printer is displayed in [Port:].

m Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check sta-
tistics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.
iE Select the [Default Printer] check box to configure the printer as default.

[E Click [Finish].
Installation starts.

Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation

AP Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, install use [Add Printer]. See p.57
“If a Message Appears during Installation”.
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Installing the PCL or RPCS Printer Driver (NetBEUI)

#Important

O To install this printer driver under Windows 2000, and Windows NT 4.0, you
must have an account that has Manage Printers permission. Log on as an Ad-
ministrators or Power Users group member.

O Windows XP and Windows Server 2003 do not support NetBEUL
O You cannot print using printers beyond routers.

ﬂ Quit all applications currently running,.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement] , and then click
[Next].

E Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

& Note

O The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

B) Click [Port:], and then click [Add].
[[!] Click [SmartDeviceMonitor], and then click [New Port...].

@ Click [NetBEUI], and then click [Search].
A list of printers using NetBEUI appears.



Using the SmartDeviceMonitor for Client Port

m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the NetBEUI
address. The NetBEUI address can be checked with the configuration page.
For information about printing a configuration page, see p.113 “Printing the
configuration page”. The NetBEUI address appears in the format of
“NARNPxoxxx\xxx” on the configuration page. Enter the machine's network
path in the format of “%%Computer name\Share name”. Use “\\” instead of
“%%” at the beginning.

[B Check that the port of the selected printer is displayed in [Port:].

m Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check sta-
tistics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.

Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.
iE Select the [Default Printer] check box to configure the printer as default.

W0 cricx [Finish].
The printer driver installation starts.

m Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

& Note
O The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Installing the PCL or RPCS Printer Driver (IPP)

#Important

O To install printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. For this, log on as an Administrators or Power Users
group member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement] , and then click
[Next].

E Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

& Note

O The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

B Glick [Port:], and then click [Add].
[[!] Click [SmartDeviceMonitor], and then click [New Port...].
ll] Click [IPP].



Using the SmartDeviceMonitor for Client Port

m In the [Printer URL] box, enter “http://printer's address/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https:/ /printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

iB Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

m Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

iE Check that the port of the selected printer is displayed in [Port:].

[E Set a user code, if necessary.

This allows a SmartDeviceMonitor for Admin user to display and check the
number of sheets each user prints. For details, see SmartDeviceMonitor for
Admin Help.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

Select the [Default Printer] check box to configure the printer as default.
iE Click [Finish].

Installation starts.

m Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use[Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

& Note
O There are no settings for NetBEUI protocol.

Windows 95/98:

ﬂ Open [Printers] window from [Start] menu. .

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Configure Port].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

ﬂ Open [Printers] window from [Start] menu. .

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ On the [Ports] tab, click [Configure Port].
The [Port Settings] dialog box appears.



Using the SmartDeviceMonitor for Client Port

Windows XP, Windows Server 2003:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

ﬂ Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
e For TCP/IP, timeout setting can be configured.

& Note

O If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

® Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

® Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box
¢ User, proxy, and timeout settings can be configured for IPP.

,O Reference

For information about these settings, see“Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

#Important

O To install printer driver under Windows 2000/ XP Professional, and Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

ﬂ Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

ﬂ Double-click the printer name to display the printer settings.

& Note
O The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

B) Click [Port:], and then click [Add].

) Click [Standard TCP/IP], and then click [New Port....

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

[l] Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.



Using the Standard TCP/IP Port

m Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

[E] Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

m Check that the port of the selected printer is displayed in [Port:].
[E Configure the default printer as necessary.

0 crick [Finish].
The printer driver installation starts.

m Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

#Important

O To install this printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

& Note
O The details shown in [Comment:], [Driver:], and [Port:] vary depending on
the operating system, printer model, and port.

B) Click [Port:], and then click [Add].

W crick [LPR Port], and then click [New Port...].
If [LPR Port] does not appear, see Windows Help and install it.

[l] Enter the printer's IP address in the [Name or address of server providing Ipd]
box.



Using the LPR Port

[ﬂ Enter “1p” in the [Name of printer or print queue on that server] box, and then click
[OK].

The port is added.
[B Check that the port of the selected printer is displayed in [Port:].

m Configure the default printer as necessary.

B crick [Finish].
The printer driver installation starts

[E Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting "Network printer
server", and then select the Windows 2000/ XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 print serv-
er. Do not begin the following procedure before the client is set up and config-
ured correctly.

ﬂlmportant

O To install printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. For this, log on as an Administrators or Power Users
group member.

O If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

O If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client.

O If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

ﬂ Quit all applications currently running,.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.



Using as the Windows Network Printer

ﬂ Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

ﬂ Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

B Click [Port:], and then click [Add].
@ Click [Network Printer], and then click [OK].

ﬂ] Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

m Select the printer you want to use, and then click [OK].
[E] Check that the port of the selected printer is displayed in [Port:].

m Configure the user code as necessary.
For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

iE Select the [Default Printer] check box to configure the printer as default.

W0 cricx [Finish].
The printer driver installation starts.

m Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Using as the NetWare Print Server/Remote
Printer

This explains how to set up the Windows computer used as the NetWare client.

ﬂlmportant

O Toinstall this printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

¢ Operating system: Windows 98

* NetWare version: 4.1

¢ File server name: CAREE

¢ Queue name: R-QUEUE

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory
ﬂ Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].
ﬂ The software license agreement appears in the [License Agreement] dialog

box.
After reading the agreement, click [l accept the agreement], and then click [Next].

ﬂ Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

E Select the [Printer Name] check box to select the printer models you want to
use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

ﬂ Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.



Using as the NetWare Print Server/Remote Printer

ﬂ Click [Port:], and then click [Add].
B Click [Network Printer], and then click [OK].

[m Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

ﬂ] Select the print queue, and then click [OK].

m Check that the port of the selected printer is displayed in [Port:].
iB Click [Finish].

The printer driver installation starts.
il] Click [Finish] in the [Component selection] dialog box.
[B Click [Finish] in the [Introduction complete] dialog box.

m In the [Printers] window, open the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

iB On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

iE Click [OK] to close the printer properties dialog box.

& Note

O The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet
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Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-

er driver on Windows. If NetWare form feed is configured, the printer may not

print properly.

Follow the procedure below to disable form feed according to the operating sys-

tem used:

¢ Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

¢ Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating

system used:

e Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

¢ Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.



Installing the Printer Driver Using USB

Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.
The printer drivers can be installed from the CD-ROM provided with this machine.

Windows 98 SE/Me - USB

#Important
O Installation via USB is not possible under Windows 95/98. Upgrade to Win-
dows 98 SE/Me.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

ﬂ Turn off the power of the machine.

ﬂ Connect the machine with the computer via USB cable.
Connect the USB cable firmly.

ﬂ Turn on the power of the computer.
ﬂ Click [Next>].

E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

E Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note
O When Auto Run starts, click [Exit].
O To disable Auto Run, press the [Shift] key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ Specify the location where USB Printing Support is located, and then click
[Next>].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:
D:\DRIVERS\USBPRINT\WIN98ME

E) Check the location, and then click [Next].
USB Printing Support is installed.
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M click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

@ Click [Next>].

iE Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

[E] Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

m Insert the CD-ROM into the CD-ROM drive.

& Note
O When Auto Run starts, click [Exit].

O To disable Auto Run, press the [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

[B Specify the location where the source files of the printer driver is stored,
and then click [Next>].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN9X_MEN\ (Language) \DISK1

e PCL 5c
D:\DRIVERS\PCL5C\WIN9X_ME\ (Language)\DISK1

e PCL6
D:ADRIVERS\PCL6AWIN9X_MEN\ (Language)\DISK1

* PostScript 3
D:ADRIVERS\PS3\WIN9X_ME\ (Language)\DISK1

M Check the location, and then click [Next].
Add Printer Wizard starts.

m Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

& Note
O The number after "USB" varies depending on the number of printers connected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.



Installing the Printer Driver Using USB

Windows 2000 - USB

ﬁlmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.
n Turn off the power of the machine.

ﬂ Connect the machine with the computer via USB cable.
Connect the USB cable firmly.

B Turn on the power of the computer.
ﬂ Click [Next] in the [Found New Hardware Wizard] dialog box.

B "Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next]."

(3 seiect the [Specify location] check box, and then click [Next].
ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note
O When Auto Run starts, click [Exit].
O To disable Auto Run, press the left [Shift] key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:ADRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5c
D:ADRIVERS\PCL5C\WIN2K_XP\(Language) \DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language) \DISK1

g Check the printer driver location, and then click [OK]. 45
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0 Click [Next].

m Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and

the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

& Note
O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

ﬂlmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

ﬂ Turn off the power of the printer.

ﬂ Connect the machine with the computer via USB cable.
Connect the USB cable firmly.

B Turn on the power of the computer.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next>].

B Insert the CD-ROM into the CD-ROM drive.

& Note
3 If Auto Run starts, click [Cancel], and then [Exit].
O To disable Auto Run, press the left [SHIFT] key when inserting the CD-

ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.



Installing the Printer Driver Using USB

E Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-

cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:
e RPCS

D:ADRIVERSARPCS\WIN2K_XP\ (Language) \DISK1

e PCL 5¢

D:\DRIVERS\PCL5C\WIN2K_XP\ (Language)\DISK1

e PCL6

D:\DRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

* PostScript 3

D:ADRIVERS\PS3\WIN2K_XP\ (Language)\DISK1

ﬂ Check the printer driver location, and then click [Next].

ﬂ Click [Continue].
ﬂ Click [Finish].

If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

& Note
O The number after “USB” varies depending on the number of printers con-
nected.
Troubleshooting USB
Problems Solutions

The machine is not automatically recognized.

Turn off the power of the machine, reconnect
the USB cable, and then turn it on again.

Windows has already configured the USB set-
tings.

Open Windows' Device Manager, and then,
under [Universal Serial Bus controllers], remove
any conflicting devices. Conflicting devices
have a yellow [!] or [?] icon by them. Take care
not to accidentally remove required devices.
For details, see Windows Help.

& Note

O When using Windows 2000/ XP or Win-
dows Server 2003, an erroneous device is
displayed under [USB Controller] in the [De-
vice Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PCL or RPCS Printer Driver

#Important

O Toinstall this printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running,.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
ﬂ Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement], and then click [Next].

E Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

ﬂ Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Check that [LPT1:] is shown in [Port:].
iE Select the [Default Printer] check box to configure the printer as default.



Printing with Parallel Connection

W crick [Finish].
The printer driver installation starts.

m Click [Finish] in the installation completion dialog box.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

AP Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.57 “If a
Message Appears during Installation”.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

ﬂlmportant
O Quit all applications currently running, and do not print during installation.

O Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

O Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

O SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

O This machine can receive print data from one computer at a time only. An
message may appear if jobs from different computers collide.

O If jobs collide, the first received is printed first.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

& Note

O If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the "1394_00n" port, click [1394_00] as a port during the printer
driver installation.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

ﬂ Connect the machine and computer using the IEEE 1394 interface cable.
EI Click [Next] in the [Found New Hardware Wizard] dialog box.

B When the message "This wizard will complete the installation for this De-
vice: Unknown" appears, click [Specify a location], and then click [Next>].

ﬂ When the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next>].



Installing the Printer Driver Using IEEE 1394 (SCSI print)

B Insert the CD-ROM into the CD-ROM drive.

& Note
3 If Auto Run starts, click [Cancel], and then [Exit].
O To disable Auto Run, press the left [SHIFT] key when inserting the CD-

ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

E Click [Browse].

ﬂ Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:

* RPCS
D:ADRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

e PCL5c
D:\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

e PCL6
D:ADRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

* PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language) \ DISK1

ﬂ Click [Open].
ﬂ Click [OK].

m Follow the instructions.
When installation is complete, the printer connected to "1394_00n" appears in

n_n

the [Printers] window. ("n" shows the number of printers connected.)

& Note

O If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not necessary.

O If printing does not work properly after the installation, delete the port and re-
install the printer driver. For details, see p.142 “The Machine Does Not Print”.

O If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

® When the [Found New Hardware Wizard] dialog box appears, click [Next>].

® When the message "This wizard will complete the installation for this
Device: Unknown" appears, select the [Search for a suitable driver for my de-
vice recommended] check box, and then click [Next>].

® When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

@ When the message "Driver Files Search Results" appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish]."

51




52

Preparing the Machine

Windows XP, Windows Server 2003

ﬁlmportant

O SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

& Note

O This machine can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

O To install another printer driver after setting the "1394_00n" port, click
[1394_00] as a port during the printer driver installation.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

ﬂ Connect the machine and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

EI Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next>].

B When the message '"Please choose your search and installation option." ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note
3 If Auto Run starts, click [Cancel], and then [Exit].
O To disable Auto Run, press the left [SHIFT] key when inserting the CD-

ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.



Installing the Printer Driver Using IEEE 1394 (SCSI print)

B Specify the location where the source files of the printer driver is stored,
and then click [Next].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

PCL 5¢
D:\DRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1

PCL6
D:ADRIVERS\PCL6AWIN2K_XP\ (Language) \DISK1

PostScript 3
D:ADRIVERS\PS3\WIN2K_XP\ (Language)\DISK1

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ('n" shows the number of printers connected.)

E Follow the instructions.

& Note

O

If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.

If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see p.142 “The Machine Does Not
Print”.

If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below

® When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next>].

® When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

® When the message "The wizard could not find the software on your
computer for.." appears, click [OK].

@ When the message "Cannot Install this Hardware" appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

Supported Profiles

< SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

Conditions for bidirectional communications
¢ SPP connection does not support bidirectional communications.

¢ HCRP connection supports bidirectional communications.

< BIP

For BIP connection, a module including PostScript 3 must be installed in
the machine.

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel inter-

face.

ﬂlmportant

O To install the printer driver under Windows 2000/ XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

& Note

O System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

O For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.



Printing with Bluetooth Connection

ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

B On the [Tool] menu, click [COM port].

ﬂ Check that the message "Bluetooth Serial Client (COMXx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B Click [Close].

E On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B on the [File] menu, click [Properties].
g Click the [Ports] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

ﬂ] Click [OK].
Close the [Printers] window.

< If adialog box appears while transmitting a print job, reestablish network connec-
tion as follows:

@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

& Note

O To always use the same printer, select the [Always use for this connection]
check box.

p Reference

For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.
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Configuring Security Mode Settings

ﬂ Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

ﬂ Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.56 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.

& Note
O For information about each mode, see the manuals provided with the utility.

ﬂ Click [OK].
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.56 “Printing in the Security Mode”.

Printing in the Security Mode

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

a The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the ma-
chine. For example, if the serial number is 00A0-001234, the Bluetooth pass-
word is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



If a Message Appears during Installation

If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

l] On the [Start] menu, point to [Settings], and then click [Printers].
ﬂ Double-click the Add Printer icon.
B Follow the instructions in Add Printer Wizard.

& Note

O If the printer driver is on a CD-ROM, the location of the RPCS printer driver
is either \DRIVERS\RPCS\WIN9X_ME, \DRIVERS\RPCS\WIN2K_XP,
or \DRIVERS\RPCS\NTH4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

l] On the [Start] menu, click [Printers and Faxes].
ﬂ Click [Add a printer].
B Follow the instructions in Add Printer Wizard.

& Note

O If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to
quit.

For Windows XP Home Editions:

l] On the [Start] menu, click [Control Panel].

EI Click [Printers and Other Hardware].

B Click [Printers and Faxes].

ﬂ Click [Install Printer].

a Follow the instructions in Add Printer Wizard.

& Note

O If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to
quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

/O Reference

For details about making option settings for the printer, see p.60 “If Bidirec-
tional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

¢ Bidirectional communication is supported by Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

¢ If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable.

& Note

O The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date machine status manually.

O The PostScript 3 printer driver does not support bidirectional communica-
tions.

To support bidirectional communication, the following conditions must be met:

< When connected with parallel cables
¢ The computer must support bidirectional communication.
¢ The machine must support bidirectional communication.
¢ The interface cable must support bidirectional communication.

¢ The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.
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% When connected with the network
* The machine must support bidirectional communication.

e SmartDeviceMonitor for Client included on the CD-ROM must be in-
stalled, and TCP/IP must be used.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.

¢ In addition to the above, one of the following conditions must also be met:

¢ The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

¢ The standard TCP/IP port must be used without changing the default
port name (for Windows 2000/ XP and Windows Server 2003).

* Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

¢ IPP port name must include the IP address when using the IPP protocol.

% When connected with IEEE 1394
* The computer must support bidirectional communication.

* The machine must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

* [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must
be selected in the Bidi-SCSI print.

e Under Windows 2000/XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [port] tab with RPCS printer driver.

< When connected with USB

The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

& Note
O Install SmartDeviceMonitor for Client from the CD-ROM provided.
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If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

® Limitation

O Under Windows 2000/XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

& Note
O If you are using the RPCS printer driver, click the [Change Accessories] tab.

O If you are using the PS printer driver, click the [Device Settings] tab.

B Select options installed from the [Option] area, and then make the necessary
settings.

E Select the total amount of the memory in [Total Memory:], when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

ﬂ Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessoties] to display the option selection.

Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Installing Font Manager 2000

Installing Font Manager 2000

? Limitation

O Under Windows 2000/ XP, Windows Server 2003, or Windows NT 4.0, install-
ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator
permission.

ﬂ Quit all applications currently running,.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Ciici [Font Manager 2000].

ﬂ Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT
4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_MEN\ (Lan-
guage)\DISK1\"” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use
the folder at this level that is appropriate for the operating system you are cur-
rently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
* For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

¢ For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

& Note

O If the driver is not set correctly after copying the ”.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

@ On the [File] menu, click [Print].
The [Print Document] dialog box appears.

@ Make the necessary settings in the [Features] box.
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PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

i@klmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
ﬂ On the [File] menu, click [Properties].
ﬂ Make the necessary settings, and then click [OK].

& Note
O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

pe Reference
For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

B on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
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B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

pe Reference
For details, see Printer Driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

#¥important

0 To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.
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Making printer default settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

pe Reference
For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print....
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

pe Reference
For details, see Printer Driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

ﬂlmportant

O To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.

Making printer default settings - Printing Preferences

#Important
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

pe Reference
For details, see Printer Driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

pe Reference
For details, see Printer Driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

#Important

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.

Making printer default settings - Default

{¥important

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

pe Reference
For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

& Note

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].

ﬂ Click [OK] to start printing.

pe Reference
For details, see Printer Driver Help.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

"Multi-tab" is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

< Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

< Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

& Note
O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
ﬂ On the [File] menu, click [Properties].

& Note

O When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

pe Reference
For details, see Printer Driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

& Note

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].

ﬂ Click [OK] to start printing.

pe Reference
For details, see Printer Driver Help.
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

#Important

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.

& Note

O When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.
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Making printer default settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

pe Reference
For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print....
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

pe Reference
For details, see Printer Driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making printer default settings - the printer properties

{¥important

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.
& Note
O When you open the printer properties dialog box initially after installing

the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.



RPCS - Accessing the Printer Properties

Making printer default settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

pe Reference
For details, see Printer Driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print....
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

pe Reference
For details, see Printer Driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

#Important

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Properties].
The printer properties dialog box appears.

& Note

O When you open the printer properties dialog box initially after installing
the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

pe Reference
For details, see Printer Driver Help.
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Making printer default settings - Default

{¥important

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

ﬂ On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

§e Reference
For details, see Printer Driver Help.

77



78

Setting Up the Printer Driver

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

& Note

O The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

O With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

B on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
B Make the necessary settings, and then click [Apply].
ﬂ Click [OK] to start printing.

pe Reference
For details, see Printer Driver Help.



4. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the
machine for printing, without having
to open a PDF application.

? Limitation

O This function is possible only when
the optional PostScript 3 unit is in-
stalled.

O This function is possible for genu-
ine Adobe PDF files only.

O Version 1.3, 1.4, and 1.5 PDF files
are compatible.

O Transparency and JBIG2 (functions
of PDF version 1.4) are not compat-
ible.

O PDF version 1.5 exclusive functions
are not compatible.

& Note

O Paper size errors may occur when
printing on custom size paper.

Printing Method

< Using DeskTopBinder Lite
PDF files registered with Desk-
TopBinder Lite can be sent directly
to the machine for printing.

? Limitation
O Use DeskTopBinder Lite on the
provided CD-ROM.

& Note

O PDF Direct Print settings can be
made from PDF Direct Print
properties.

O When printing PDF files for which
a password is set, one of the fol-
lowing settings is required:
¢ Enter the PDF password from

PDF Direct Print properties.
The RPCS printer driver must
be installed.

¢ To set the PDF password, se-
lect [Change PDF Password] on
the [PDF Menu] in Printer Fea-
tures.

O When a group password is set
with DeskTopBinder Lite, set a
group password using [PDF
Group Password] on the [PDF
Menu] in Printer Features.

/O Reference

For details, see DeskTopBinder
Lite Help.

< Using commands
From UNIX, you can print PDF
files directly, using commands
such as “ftp” and “Ipr”.
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Using Locked & Sample Print Job List

A list of files stored in the machine can be viewed on the display panel.

n Press the [Printer] key.

AEU036S

The Printer screen appears.

EI Press [Locked & Sample Print Job List].




Using Locked & Sample Print Job List

4.

A list of files stored in the machine appears.

Locked & Sample Print Job List
el s

s
D —aa
Senpl i 16 Lt " 1
tekte

. [Complete List]

Displays all files stored in the ma-
chine.

. [Locked Print Job List]

Displays only locked print files stored
in the machine. See p.86 “Locked
Print”.

. [Sample Print Job List]

Displays only sample print files
stored in the machine. See p.82 “Sam-
ple Print”.

User ID, Date/Time, and Qty. dis-

play

Displays the time when the instruc-
tion to print the stored files was en-
tered, User ID, and the remaining
number of copies.

& Note

5. [APrev.] / [VNext]

If the list of files does not fit on the
screen, scroll down to view the list.

6. [Exit]

Returns to the Printer screen.

7. [Details]

Displays details about the selected
file.

8. [Print]

Prints the selected file.

9. [Delete]

Deletes the selected file.

O The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press [Exit] to return to the Printer
screen, and then press [Locked & Sample Print Job List] again.
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Sample Print

Use this function to print only the first
set of a multiple-set print job. After
you have checked the result, remain-
ing sets can be printed or canceled us-
ing the machine's control panel. This
can reduce misprints due to mistakes
in content or settings.

& Note

O If the application has a collate op-
tion, make sure it is not selected
before sending a print job. By de-
fault, sample print jobs are auto-
matically collated by the printer
driver. If a collate option is select-
ed from the application's [Print] di-
alog box, more prints than
intended may be produced.

O You can identify the file you want
to print by user ID and date and
time when the job was stored.

O The number of pages the machine
can save depends on the contents of
the print image. For example, the
machine can save up to 30 jobs or
1,000 pages, including locked print
files, depending on data volume.

O If the first set of the sample print
files is not as you expected and you
do not want to print remaining
sets, delete the sample print file us-
ing the display panel. If you print
the remaining sets of the sample
print file, the job in the machine is
deleted automatically.

O Turning off the machine's main
power switch deletes sample print
files.

Printing a Sample Print File

The following procedure describes
how to print a sample print file with
the PCL 6 / 5c and the RPCS printer
driver. For information about how to
print a sample print file with the Post-
Script 3 printer driver, see PostScript 3
Supplement included as a PDF file on
the CD-ROM.

? Limitation

O Applications with their own driv-
ers, such as PageMaker, do not
support this function.

O If you are using Mac OS X, you
need Mac OS X v10.2 or higher to
use this function.

ﬂ Configure the sample print in the
printer driver's properties.

/O Reference

For details about configuring
the printer drivers, see the rele-
vant Help files.

ﬂ Start printing from the applica-
tion's [Print] dialog box.
& Note
O Make sure to set more than two
copies.
The sample print job is sent to the
machine, and the first set is printed.



Sample Print

B On the machine's control panel, E Select the file you want to print
press the [Printer] key to display by pressing it.
the Printer screen.
& Note

O Press [APrev.] or [WNext] to scroll

[
through the list.

0D O Only one file can be selected at a
time.

ﬂ Press [Print] to change the number
of sets to be printed.

B Enter the new number of sets us-
pre ing the number keys.

ﬂ Press [Locked & Sample Print Job List].

@ e you sure you wart o et e flloving?

User D 0001
Fil Nam: 0001, doc

The et quanttycan b chnger
a5 <

P b Lists & EmrLog

() [ If you do not want to change the
set quantity, proceed to step ).

A list of the print files stored in the 9
machine appears. Note

B . ) O You can enter up to 999 sets.
Press [Sample Print Job List]. O Press [Clear/Stop] to correct any

A list of the sample print files entry mistakes.

stored in the machine appears.

— B press ves].
d&sam""“t N The remaining sets are printed.
) on | s | | =
‘ & Note
e inti
O Press [No] to cancel printing.
O When printing is completed, the
The following items also appear: stored file will be deleted.
* User ID: The user ID set up by O To cancel printing, press [Exit].
the printer driver. After that, press [Job Reset]. Af-
e Date / Time: The date and time ter it has started, the file will be
when the job was sent from the deleted.
computer. O Remaining print jobs are print-
* Qty.: The number of remaining ed before the sample print job.
sets.
& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.
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Deleting a Sample Print File

Checking the Error Log

If you are not satisfied with the sam-
ple printout, you can delete the sam-
ple print file, revise it and print it
again until the settings are suitable.

ﬂ Press the [Printer] key to display
the Printer screen.

EI Press [Locked & Sample Print Job List].

A list of the print files stored in the
machine appears.

B press [Sample Print Job List].
A list of sample print files stored in
the machine appears.

& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.

ﬂ Select the file you want to delete
by pressing it.

& Note

O Press [APrev.] or [¥Next] to scroll
through the list.

O Only one file can be selected at a
time.
B Press [Delete].
The delete confirmation screen
will appear.
E Press [Yes] to delete the file.
After the file has been deleted, the

file list screen will return.

& Note

O If you do not want to delete the
file, press [No].

If a file could not be stored, you can
check the error log on the control panel.

? Limitation

3 The latest 30 error files are stored
in the error log. If a new error file is
added when there are 30 error files
already stored, the oldest file is de-
leted. However, if the oldest error
file is a sample print file, it is not
deleted, but stored instead in the
sample print error log until the
number of sample print error files
reaches 20.

O If the main power switch is turned
off, the log is deleted.

B press the [Printer] key to display
the Printer screen.

ﬂ Press [Error Log].

> Job Lists & EnrLig

nnnnnn

B press [Sample Print Job List].

& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.



Sample Print

ﬂ Press [Details].

Show Error Log

et e

b en  renm vse T ee e
[t T TUEE 1212 | e o v ot
Ceieap

An error log list appears.

Show Error Log S Pt b s
016 Neme
o, U001 D Tie: 11725 11:12
o0t cee S [
e w =
@

O Press [APrev.] or [¥Next] to scroll
through the error files.

O Press [Exit] after checking the
log.

O To print files that appear in the
error log, resend them after

stored files have been printed or
deleted.
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Locked Print

Use this function to maintain privacy
when printing confidential docu-
ments on the machine over a shared
network. Usually, it is possible to
print data using the display panel
once it is stored in this machine.
When using Locked Print, it is not
possible to print unless a password is
entered on the machine's display pan-
el. Your confidential documents will
be safe from being viewed by other

people.

& Note

O If the application has a collate op-
tion, make sure it is not selected
before sending a print job. Locked
print jobs are automatically collat-
ed by the printer driver as default.
If a collate option is selected in the
application print dialog box, more
sets than intended may be printed.

O You can identify the file you want
to print by User ID, and date and
time when the job was stored.

O The number of pages the machine
can save depends on print image
content. For example, the machine
can save up to 30 jobs or 1,000 pag-
es including sample print files, de-
pending on data volume.

O After the locked print file is print-
ed, the job is automatically deleted.

O Turning off the machine's main
power switch deletes locked print
files.

Printing a Locked Print File

The following procedure describes
how to print a locked print file with
the PCL 6 / 5c and the RPCS printer
driver. For information about how to
print a locked print file with the Post-
Script 3 printer driver, see PostScript 3
Supplement included as a PDF file on
the CD-ROM.

? Limitation

O Applications with their own driv-
ers, such as PageMaker, do not
support this function.

O If you are using Mac OS X, you
need Mac OS X v10.2 and higher to
use this function.

ﬂ Configure the locked print in the
printer driver's properties.

pe Reference
For details about configuring
the printer drivers, see the cor-
responding Help files.

aStart printing from the applica-
tion's [Print] dialog box.
The locked print job is sent to the
machine.

B On the machine's control panel,
press the [Printer] key to display
the Printer screen.

ﬂ Press [Locked & Sample Print Job List].

A list of the print files stored in the
machine appears.



Locked Print

B Press [Locked Print Job List].

A list of the locked print files
stored in the machine appears.

Locked & Sample Print Job List

The following items also appear:

* User ID: The user ID set up by
the printer driver.

¢ Date / Time: The date and time
when the job was sent from the
computer.

& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.

E Select the file you want to print
by pressing it.
& Note
O Press [APrev.] or [¥Next] to scroll
through the list.

O Only one file can be selected at a
time.

ﬂ Press [Print].
The password screen appears.

B Enter the password using the
number keys, and then press [OK].

The print confirmation screen ap-
pears.

& Note

O A confirmation screen will ap-
pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

ﬂ Press [Yes].
The locked file is printed.

& Note

O Press [No] to cancel printing.

O To cancel printing, press [Exit].
After that, press [Job Reset]. Af-

ter it has started, the file will be
deleted.

Deleting Locked Print Files

B press the [Printer] key to display
the Printer screen.

EI Press [Locked & Sample Print Job List].

> Job Lists & EnrLig

nnnnnn

A list of the print files stored in the
machine appears.

B Press [Locked Print Job List].
A list of the locked print files

stored appears.

& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.

ﬂ Select the file you want to delete
by pressing it.

& Note
3 Press [APrev.] or [VNext] to scroll
through the list.

O Only one file can be selected at a
time.

B Press [Delete].
The password screen is displayed.
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E Enter the password using the
number keys, and then press [OK].

The delete confirmation screen ap-
pears.

& Note

O A confirmation screen will ap-
pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

£ press [ves).
After the file has been deleted, the

file list screen returns.

@ Note

O If you do not want to delete the
file, press [No].

Checking the Error Log

If a file could not be stored in this ma-
chine, you can check the error log on
the display panel.

? Limitation

3 The latest 30 error files are stored
in the error log. If a new error file is
added when there are 30 error files
already stored, the oldest file is de-
leted. However, if the oldest error
fileis a locked print file, it is not de-
leted, but stored instead in the
locked print error log until the
number of locked print error files
reaches 20.

O If the main power switch is turned
off, the log will be deleted.

B press the [Printer] key to display
the Printer screen.

ﬂ Press [Error Log].

[rnres l > s

nnnnnn

B select [Locked Print Job List].

& Note

O Depending on the security set-
tings, certain print jobs may not
be displayed.

B press [Details].

An error log list appears.

Show Error Log

Nane.
User I0:0001 et Tive: 11/26 10:57

an
ceeded a1 pages I sagle i 0 ocked it

& Note

3 Press [APrev.] or [WNext] to scroll
through the error files.

O Press [Exit] after checking the
log.

O To print files that appear in the
error log, resend them after
stored files have been printed or

deleted.



Collate

Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer in memory. The following are the three types of
collate:

< Collate

Printed output is assembled as sets in sequential order.

1000

< Rotating Collate
Every other print set is rotated by 90 degrees [J.

Iy

« Shift Collate
(The optional finisher is required for this function.)
The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

AEU016S

AEU017S

AEU018S

? Limitation

O The optional finisher is required for Shift Collate.

O Rotating Collate is not possible when feeding paper from the bypass tray.
O Shift Collate is not possible when printing on 8!/, x 5! /,[5.

O If jobs containing pages of various sizes are set, Rotating Collate will not
work.

O Rotating Collate, Staple, and Punch functions cannot be combined.
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& Note
O You can set Collate in the RPCS printer driver.

¢ If you cannot make Shift Collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings. For details, see the printer driver Help.

O If Auto Continue occurs on the first set, Collate will be canceled.
O If forced printing occurs on the first set, Collate will be canceled.

O If a document with mixed paper sizes or sizes larger than A4, 81/, “x 11" is
set, it can only be collated, even if Rotating Collate has been selected.

O If the following functions are selected, Collate or Shift Collate will be applied
even if Rotating Collate is selected:

e Covers
e Slip Sheet

O When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

O When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

O The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.

AO Reference

For information about paper sizes and the number of sets you can use Collate,
Rotating Collate, and Shift Collate with in every option, see Copy Reference.

For printing methods, see the printer driver Help.



Printing with the Finisher

Printing with the Finisher

You can collate, staple or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher:

A Reference
For information about optional finishers, see General Settings Guide.

To use the staple function, see p.92 “Staple”.
To use the punch function, see p.96 “Punch”.

< Be sure to make settings for options installed on the machine in the printer drivers.

/O Reference

To make settings for options in the printer drivers, see p.58 “Making Op-
tion Settings for the Printer”.

< Be sure to set the paper size and paper orientation in the printer driver when using
duplex printing, booklet, combine (layout), staple and punch functions.

A Reference
For information about duplex printing, booklet, and layout, see the printer
driver Help.

To use the staple function, see p.92 “Staple” and the printer driver Help.
To use the punch function, see p.96 “Punch” and the printer driver Help.

& Note
O Depending on the application, print settings may not be enabled and printed
output may not be as expected.

< When setting staple or collate in the printer driver, make sure that the Collate check
box is cleared in the application's [Print] dialog box.
If Collate is enabled in the application, printing will not be as intended.
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Staple

With the optional finisher installed, sets can be stapled individually when print-
ing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

Paper Orientation | Print Data | Staple 2 Tray Booklet
on the Machine Direction Position Finisher Finisher
D E Top Left Slant E X
-
Vertical
Top Right Slant X X
Top Left E E
Top Right E E
2 at Top X X
2 at Left E E
2 at Right E E
2 at Center X X
El Top Left Slant X X
Horizontal
Top Right Slant E X
Top Left
Top Right
2 at Top
2 at Left X X
2 at Right X X
2 at Center X X

X means that the staple position is not supported. AEU037S



Printing with the Finisher

Paper Orientation | Print Data | Staple 2 Tray Booklet
on the Machine Direction Position Finisher Finisher
(I E Top Left Slant X X
-
Vertical
Top Right Slant E X
Top Left E E
Top Right E E
2 at Top
2 at Left X X
2 at Right X X
2 at Center X
E Top Left Slant X
Horizontal
Top Right Slant X X
Top Right
2 at Top X X
2atLef R R
2 at Right [R]
2 at Center X
X : means that the staple position is not supported. AEU038S

p Reference

¢ For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, General Settings Guide.

* For printing methods, see the printer driver Help.

¢ The staple position will vary when using the PostScript 3 printer driver.
For more information, see the PostScript 3 printer driver Help.
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Stapling Precautions

? Limitation

O Stapling can be done only with the optional finisher installed.

O Stapling cannot be done when paper is fed from the bypass tray.

O You cannot interrupt the current job with a job for another function requiring
stapling or collating.

O When printing on letterhead, stapling may not be at the specified position.

O When the optional booklet finisher is installed, and PostScript 3 is used, you
cannot specify [2 at Center].

& Note

O When the finisher is installed, and when an output tray that cannot output us-
ing the staple function has been selected, the paper will be output according
to System Settings.

O If you cannot make staple settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

O When duplex printing is selected, adjust staple positions to the binding orien-
tation.

O When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

O When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.

O Be sure to set paper size and orientation in the printer driver when stapling.

* Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.

O When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.

¢ If the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where
the paper jam occurred.

¢ If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

O Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.



Printing with the Finisher

O Staple printing will be canceled under the following conditions:

If the number of staple jobs exceeds maximum. For information about the
maximum number, see “Specifications”, General Settings Guide.

If a paper size that cannot be stapled is selected. For information about pa-
per sizes that can be stapled, see “Specifications”, General Settings Guide.

If positions other than those fixed for stapling are specified.

If there are inconsistencies between the orientation in duplex mode and the
staple position.

If paper sizes are mixed when a different paper size is specified during a
print job.

When staples have run out.

When feeding paper from the bypass tray.

When staples have run out and Auto Continue is set, printing will continue
without stapling after the message has been displayed.

O When using the optional 2 tray finisher or optional booklet finisher to select
other than [2 at Center], the following paper sizes can be stapled using Mixed
Size mode:

A3[F and A4 [J
B4FZ and B5 [J
11x173F and 81 /o x 11[)
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Punch

With the optional finisher installed, holes can be punched into printed output.

Punch Position

The specified punch position varies depending on paper feed and print data ori-
entation. The following table shows punch positions:

Punch Position

Paper Orientation | Print Data
on the Machine Direction 2 holes 3 holes 4 holes
Vertical @
o o o o M
. o
Horizontal .RHR. :RHR: ERHR:

& Note

AEV031S

O Punch positions will vary slightly from page to page as holes are punched
into each sheet individually.

/O Reference

For information about paper sizes that can be punched, see “Specifications”,
General Settings Guide.

For printing methods, see the printer driver Help.

The punch position will vary when using the PostScript 3 printer driver. For
details, see the PostScript 3 printer driver Help.



Printing with the Finisher

Punching Precautions

e Limitation

O Punching cannot be done when paper is fed from the bypass tray.

& Note

O If you cannot make punch settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

O When duplex printing is selected, adjust punch positions according to bind-
ing orientation.

O Be sure to set the punch position the same as the staple position when using
it with the staple function.

O Be sure to set paper size and orientation in the printer driver when punching.

Depending on the software you are using, print settings may not be ena-
bled and the printed result may not be as expected.

O Punch will be canceled under the following conditions:

When a paper size that cannot be punched is selected. For information
about paper sizes that can be punched, see “Specifications”, General Set-
tings Guide.

If positions other than those fixed for punching are specified.

If there are inconsistencies between the orientation in duplex mode and the
punch position.

When feeding paper from the bypass tray.

When the punch receptacle has become full and Auto Continue is set,
printing will continue without punching after the message appears.
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

ﬂlmportant

O During Spool Printing, the hard disk is accessed and the Data-In indicator
blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power to the
computer or machine off during Spool Printing.

? Limitation

O If data is sent to the machine using other protocols besides diprint, lpz, ipp,
and smb, Spool Printing cannot be performed.

O Up to a maximum of 150 jobs at once can be spool printed.

& Note
O Printing the first page with Spool Printing will be slow.

O The computer requires less print processing time when large amounts of data
are spooled.

O Stored spool jobs can be viewed or deleted using a Web browser.

< Setting Spool Printing
Spool Printing can be set using telnet or a Web browser.
¢ Using a Web browser
See Network Guide or Help for more information.
¢ Using telnet

Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.

< Viewing a list of spool jobs on the display panel
If Spool Printing is set, a list of spooled jobs can be viewed on the display pan-
el screen.
Press the [Printer] key, and then press [Spooling Job List]. A list of spooled jobs
appears.
¢ Deleting jobs
Select files to be deleted, and then press [Delete].

& Note
O If Spool Printing is not set, you cannot select [Spooling Job List].

< Viewing/Deleting spool jobs in a Web browser
Start the Web browser and enter the machine's I’ address in the address bar.
This displays the top page.
For more information, see Network Guide.



Covers

Covers

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

A Reference
For printing methods, see the printer driver Help.

? Limitation
O To use this function, Collate must be set. Rotating Collate cannot be set.

& Note

O The cover sheets should be the same size and orientation as the body of the
paper.

O If "Auto Tray Select" is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the [J orientation. There-
fore, if the cover paper is set to [ orientation, the orientation of cover and
body will be different.
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% Cover Sheet
Prints the first page of the document on the sheet for the cover page.

* Print on one side
Prints on one side of the cover sheet only, even when duplex printing is se-

AEV016S

¢ Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.

* Front cover printed on both sides

Ty

2

1

AEV017S

* Front cover printed on one side

PgP

: 7

1 1

AEV032S

¢ Blank
* When printing one side

P-gl

2
1 1

AEV018S

* When printing both sides

-7

: 7

1

AEV033S



Covers

« Front and Back Covers
Prints the first and last page of the document as the cover and back cover pages.

* Print on one side
Prints on one side of the cover sheets only, even when duplex printing is
selected.

* Back cover page face inside

=gl

2
112 1

AEV034S

¢ Back cover page face outside

.59

1 2

AEV035S

* Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.

* Front cover printed on both sides, back cover page face inside, and the
number of pages is even

WepF

4 2

AEV036S

¢ Front cover printed on both sides, back cover page face inside, and the
number of pages is odd

Tepb

4 2

AEV037S

101



Other Print Operations

* Front cover printed on one side, back cover page face inside, and the
number of pages is even

g

112 1

AEV038S

¢ Front cover printed on one side, back cover page face inside, and the
number of pages is odd

. [Tei?

3

12 1

AEV039S

¢ Blank
¢ When printing one side

el

142 1

T

AEV040S

¢ When printing both sides

T

2 A

AEV041S
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Slip Sheet

Slip Sheet

< Inserting a slip sheet between each page

o-%

« Inserting a slip sheet between OHP transparencies

AEU023S

AEU024S

& Note
O Collate cannot be set when using slip sheets.

O When the duplex printing or cover printing is set, you cannot insert slip
sheets.

O The slip sheet should be the same size and orientation as the main paper.

O If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in [J orientation.
Therefore, when the cover paper has been set to [ orientation, the orienta-
tion of the output cover paper and body paper will be different.

O The same paper feed tray cannot be set for the main paper and slip sheets.
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User Defined Pages

Using this function, you can specify the page numbers for each input tray.

AP Reference
For printing methods, see the printer driver Help.

? Limitation
O This function is available with the PCL 6/5c printer driver only.

O If [Document Server] is selected under [Job Type:], User Defined Page cannot be
used.

O If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Lay-
out:] cannot be selected.

O If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Book-
let] under [Duplex:] cannot be selected.

AEV044S



Form Feed

Form Feed

This section gives instructions for op-
erating the machine when there is no
tray for the selected paper size or
type, or when paper loaded in the
machine has run out.

? Limitation

O The tray cannot be changed if the

following functions are set for it:

e Staple

¢ Punch

* Duplex Printing to a tray that
does not support duplex print-
ing

* Cover Sheet

¢ Front and Back Covers

* Slip Sheet

& Note

O If form feed is selected for a tray
with the following settings, you
can change the tray by canceling
the settings:

e Staple
e Punch

O If Auto Continue is selected, form
fed paper is printed after a set in-
terval. See p.115 “System”.

If the machine does not have a tray for
the selected paper size or paper type,
or if the selected paper loaded in the
machine has run out, a caution mes-
sage appears.

If this message appears, do one of the
following:

Print Using a Selected Tray

n Select the tray for form feed from
those that appear on the display
panel.

If you want to print after adding
paper to the tray, select the tray af-
ter loading the correct paper.

& Note

O To load paper in the bypass
tray, see p.14 “Setting Paper on
the Bypass Tray”.

EI Press [Continue].

The machine prints using the se-
lected tray.

& Note

O If a tray with a smaller paper
size is selected, the print job
may be cut short, or other prob-
lems may occur.
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iﬁklmportant
O If the machine is shared by mul-
tiple computers, be careful not

Canceling Form Feed

@ rress [Reset]. to accidentally cancel someone
Delete the stored print job, and else’s print job.

then cancel form feed. O Under Windows, If the machine

i ted to th t -

ﬂ Press [Reset Current Job] or [Reset O o PR U

ing a parallel cable, sent print
jobs may be canceled if [Reset All
Jobs] is pressed while “wait-
ing...” is on the display panel.
After the interval set in [I/O Time-
out] in Printer Features has

All Jobs].

s passed, the next print job can be
sent. A print job sent from a dif-
* [Reset Current Job]: cancels the ferent client computer will not
print job currently being proc- be canceled in this case.
essed.
& Note

* [Reset All Jobs]: cancels all jobs
in the print queue.

* [Resume Printing]: resumes print-
ing jobs.

O You cannot stop printing data
that has already been proc-
essed. For this reason, printing
may continue for a few pages

A confirmation message appears. after you press [Job Reset].

O A print job containing a large

P Yes] t 1 the print job.
B ress [Yes] to cancel the print jo volume of data may take con-

& Note siderable time to stop.
O Press [No] to return to the previ- L Reference
ous display.

p-107 “Canceling a Print Job”
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Canceling a Print Job

Canceling a Print Job

E Press [Reset Current Job] or [Reset

Windows - Canceling a Print Job

n Double-click the printer icon on
the Windows task tray.

A window appears, showing all
print jobs currently queued for
printing. Check the current status
of the job you want to cancel.

ﬂ Select the name of the job you want
to cancel.

B On the [Document] menu, click [Can-
cel Printing].

& Note

O In Windows XP, Windows Serv-
er 2003, and Windows NT 4.0,
click [cancel] on the [Document]
menu.

O In Windows 95/98/Me /2000 or
Windows NT 4.0, you can also
open the print job queue win-
dow by double-clicking the ma-
chine icon in the [Printers]
machine window (the [Printers
and Faxes] window under Win-
dows XP and Windows Server
2003).

ﬂ Press the [Printer] key on the ma-
chine's control panel.

BPress [Job Reset] on the display
panel.

Tray Status 18 02w of3w ofaw of w1
A4|A4| AT A3 |cmoe

[tz samprrmimia] | Tl 11

All Jobs].

¢ [Reset Current Job]: cancels the
print job currently being proc-
essed.

¢ [Reset All Jobs]: cancels all jobs
in the print queue.

¢ [Resume Printing]: resumes print-
ing jobs.
A confirmation message appears.

ﬂ Press [Yes] to cancel the print job.

& Note

O Press [No] to return to the previ-
ous display.

#¥important

O If the machine is shared by mul-
tiple computers, be careful not
to accidentally cancel someone
else's print job.

O If the machine is connected to
the computer using a parallel
cable, sent print jobs may be
canceled if [Reset All Jobs] is
pressed while “waiting...” is
on the display panel. After the
interval set in [I/O Timeout] in
Printer Features has passed, the
next print job can be sent. A
print job sent from a different
client computer will not be can-
celed in this case.
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& Note

O You cannot stop printing data
that has already been proc-
essed. For this reason, printing
may continue for a few pages
after you press [Job Reset].

O A print job containing a large
volume of data may take con-
siderable time to stop.



pe Reference

For more information about copier features and system settings, see Copy Ref-
erence and General Settings Guide.

Printer Features Menu

There are seven menu items in the Printer Features menu:

List / Test Print

¢ Maintenance
® System
¢ Host Interface
¢ PCL Menu
* PS Menu (optional)
¢ PDF Menu (optional)
You can select the functions in the following table:
Menu Default
List / Test Print Config. Sheet and Error Log
See p.113 “List / Test Config. Page
Print”.
Error Log
Menu List
PCL Config. / Font Page
PS Config. / Font Page !
PDF Config. / Font Page !
Hex Dump
Maintenance Menu Protect
See p.115 “Maintenance”. | [ ig¢ / Test Print Lock
4 Colour Graphic Mode
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Printer Features

Menu Default

System Print Error Report

See p.115 “System”. Auto Continue

Memory Overflow

Job Separation 2

Memory Usage

Duplex

Copies

Blank Page Print

B&W Page Detect

Printer Language !

Sub Paper Size

Page Size

Letterhead Setting

Bypass Tray Setting Priority

Default Printer Language !

Host Interface 1/0 Buffer
See p.118 “Host Inter- /0 Timeout
face”.

PCL Menu Orientation
See p.119 “PCLMenu”. | Borm Lines
Extend A4 Width

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Extend A4 Width

Append CR to LF

Resolution

PS Menu (optional) Data Format

See p.120 “PS Menu”. Resolution

Colour Setting

Colour Profile
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Printer Features Menu

Menu Default
PDF Menu Change PDF Password
(optional) ™ PDF Group Password
See p.121 “PDF Menu”. Resolution
Colour Setting

Colour Profile

"l Appears when the PostScript 3 unit (optional) is installed.
2. Appears when a finisher (optional) is installed.
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Printer Features

Adjusting Printer Features

Printer Features allows basic adjustment of operations when using the machine
as a printer.

Although factory default settings are suitable for most printing jobs, Printer Fea-
tures gives you access to a number of settings that control basic printer opera-
tions. Printer Features settings you make are retained even when you turn off
the machine.

For more information about copier features and system settings, see Copy Refer-
ence and General Settings Guide.

l] Press the [User Tools/Counter] key on the control panel.
EI Press [Printer Features].
B Select the desired item by pressing the tab, and then change its settings.

& Note
O [OK]: Press to make new settings and go back to previous menus.

O [Cancel]: Press to return to a previous menu without changing any setting.

ﬂ After changing Printer Features settings, press [EXit] to return to the User
Tools / Counter menu.

& Note

O You can also exit from the User Tools / Counter menu by pressing the [Us-
er Tools/Counter] key.

O Changes made to functions remain in effect even if the machine is turned
off.

O You can also exit from the Printer Features menu by pressing [Exit] in the
main menu.



Printer Features Parameters

Printer Features Parameters

List / Test Print

< Config. Sheet and Error Log
You can print the configuration
page and error log.

< Config. Page
You can print the machine's cur-
rent configuration values.

/O Reference

p-113 “Printing the configura-
tion page”

< Error Log
You can print error logs listing all
the errors that occurred during
printing.
The latest 30 error files are stored
in the error log. If a new error file is
added when there are 30 error files
already stored, the oldest file is de-
leted. However, if the oldest error
file is a sample print file or a locked
print file, it is not deleted, but
stored instead in a corresponding
print error log until the number of
those print error files reaches 20.
In addition to error logs, records of
Auto Job Cancel and jobs canceled
manually from the control panel
can be printed.

«» Menu List
You can print a Menu List showing
the machine's function menus.

< PCL Config. / Font Page
You can print the current configu-
ration and installed PCL font list.

< PS Config. / Font Page
You can print the current configu-
ration and installed PostScript font
list.

& Note

O This menu can be selected only
when the optional PostScript 3
unit is installed.

< PDF Config. / Font Page
You can print the current configu-
ration and installed PDF font list.

& Note

O This menu can be selected only
when the optional PostScript 3
unit is installed.

< Hex Dump
You can print the Hex Dump.

Printing the configuration page

l] Press the [User Tools/Counter] key
on the control panel.

The User Tools / Counter menu
appears.

EI Press [Printer Features].

The Printer Features menu ap-
pears.

PCL Cunt ot Pae

BPress [Config. Page] on the [List /
Test Print] tab.

The configuration page is printed.
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Interpreting the configuration page

< System Reference

¢ Unit Number
Displays the serial number as-
signed to the board by its manu-
facturer.

¢ Total Memory
Displays the total amount of
memory (SDRAM) installed on
the printer.

e Firmware Version

¢ Printer
Displays the version number
of the printer firmware.

¢ System
Displays the version number
of the system firmware.

¢ Engine
Displays the version number
of the printer engine.

e LCDC
Displays the version number
of the panel display.

* NIB
Displays the version number
of the Network interface.

* Controller Option
This item(s) appears when the
controller option(s) is installed.

¢ HDD: Font / Macro Download
Displays the capacity of the
hard disk drive.

¢ Printer Language
Displays the version number of
the printer driver language.

¢ Options
Displays optional trays in-
stalled.

¢ Consumption Status
Displays the amount of toner re-
maining.

< Paper Input
Displays settings made under the
Paper Input menu.

< Maintenance
Displays settings made under the
Maintenance menu.

« System
Displays settings made under the
System menu.

/O Reference
p-115 “System”

% PCL Menu
Displays settings made under PCL
Menu.

/O Reference
p-119 “PCL Menu”

% PS Menu
Displays settings made under PS
Menu.

/O Reference
p-120 “PS Menu”

< PDF Menu
Displays settings made under PDF
Menu.

/O Reference
p-121 “PDF Menu”

 Host Interface

Displays settings made under the
Host Interface menu.

When DHCP is active on the net-
work, the actual IP address, subnet
mask and gateway address appear
in parentheses on the configura-
tion page.

/O Reference
p-118 “Host Interface”

« Interface Information
Displays the interface information.
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Maintenance System

< Menu Protect < Print Error Report

This procedure lets you protect menu
settings from accidental change. It
makes it impossible to change menu
settings with normal procedures un-
less you perform the required key op-
erations. In a network environment,
only administrators can make chang-
es to menu settings.
e Levell
You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, "PS Menu" and
"PDF Menu".
e Level 2
You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, "PS Menu", "PDF
Menu" and "Tray Paper Set-
tings" in System Settings.
o Off

& Note
O Default: Level 2

O You can protect menu settings
using a Web browser.

« List/Test Print Lock

You can lock the [List / Test Print]
menu.

e On
o Off

& Note
O Default: Off

« 4 Colour Graphic Mode

¢ Text Priority
Use the optimum CMYK toner
combination for text printing.

¢ Photo Priority
Use the optimum CMYK toner
combination for photo printing.

& Note
O Default: Photo Priority

Select this to have an error report
printed when a printer or memory
eITor OCcurs.

¢ On
o Off

& Note
O Default: Off

« Auto Continue

You can select this to enable Auto
Continue. When it is On, printing
continues after a system error oc-
curs.

o Off

¢ Immediate
¢ 1 minute
* 5 minutes
¢ 10 minutes

e 15 minutes

& Note
O Default: Off

< Memory Overflow

Select this to have a memory over-
flow error report printed.

¢ Do not Print

e Error Information

& Note
O Default: Do not Print

< Job Separation

You can enable Job Separation.
¢ On

o Off

& Note

O Default: Off

O This menu appears only when a
finisher (optional) is installed.
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< Memory Usage

You can select the amount of mem-
ory used in Font Priority or Frame
Priority, according to paper size or
resolution.

¢ TFont Priority
This setting uses memory for
registering fonts.

¢ Frame Priority
This setting uses frame memory
for high speed printing.

& Note
O Default: Frame Priority

< Duplex

You can select to have print on
both sides of each page.

o Off
* Long Edge Bind
¢ Short Edge Bind

& Note
O Default: Off

< Copies

You can specify the number of
print sets. This setting is disabled if
the number of pages to print has
been specified with the printer
driver or another command.

e 1t0999 by 1

& Note
O Default: 1

<>

2y
*

*

o
*

*

Blank Page Print

You can select whether or not to

print blank pages.

¢ On

o Off

Pages that match one of the follow-

ing conditions are identified as

blank.

* There are no images.

¢ There are images but they are
outside of the printable area.

¢ There are only blank characters.

& Note
O Default: On
O The printer does not identify

pages with white-coloured im-
ages as blank.

B&W Page Detect
Set this to enable B&W Page De-
tect.

e On
o Off

& Note
O Default: On

Printer Language

You can specify the printer lan-
guage.

e Auto

e PCL

e PS

e PDF

& Note
O Default: Auto
O This menu appears only when

the PostScript 3 unit (optional)
is installed.
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< Sub Paper Size

You can enable the Auto Substitute
Paper Size (A4<LT) feature.

e Auto
o Off

& Note
O Default: Off

Page Size
You can select the default paper
size.

e 11x17
o 81/,x14
e 81/5x11
o 51/2%x81/,
o 71/4x10'/,
e 8§x13
e 81/5,x13
o 81/4x13
e A3
e B4JIS
e A4
e B5]IS
e A5
e A6
e 8K
e 16K
o 41/gx 91/,
o 37/sx7/2
e C5Env
e C6Env
e DL Env
e Custom Size
& Note
O Default:
e Metric version: A4
e Inch version: 81/, x 11

< Letterhead Setting

You can rotate original images
when printing.

When printing, original images are
always rotated by 180 degrees.
Therefore, output might not be as
expected when printing onto let-
terhead or preprinted paper re-
quiring orientation. Using this
function, you can specify image ro-
tation.

o Off
e Auto Detect
¢ On (Always)

& Note

O Default: Off

O When set to Off, original images
are rotated by 180 degrees.

O When set to Auto Detect, the
machine detects a letterhead or
preprinted paper automatically,
and does not rotate them.

O When set to On (Always), the
machine does not rotate.

O This function reduces printing
speed.

< Bypass Tray Setting Priority

You can specify which of the two
options, (Printer) Driver / Com-
mand or Machine Settings, has pri-
ority for determining the paper
size for the bypass tray.

e Driver / Command
¢ Machine Settings

& Note
O Default: Driver / Command
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< Default Printer Language

You can set the default printer lan-
guage if the machine cannot find
the printer language automatically.

e PCL
e PS
e PDF

& Note
O Default: PCL
O This menu appears only when

the PostScript 3 unit (optional)
is installed.

Host Interface

< 1/0 Buffer

You can set the size of the I/O
Buffer. Normally it is not neces-
sary to change this setting.

e 128 KB
e 256 KB
e 512KB

& Note
O Default: 128 KB

< 1/0 Timeout

You can set how many seconds the
machine should wait before end-
ing a printjob. If data from another
port usually arrives in the middle
of a print job, you should increase
this timeout period.

e 10 seconds
¢ 15 seconds
e 20 seconds
e 25 seconds

¢ 60 seconds

& Note
O Default: 15 seconds
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PCL Menu

+ Orientation
You can set the page orientation.

¢ Portrait
¢ Landscape

& Note
O Default: Portrait

« Form Lines
You can set the number of lines per

page.
e 5t0128by 1

& Note
O Default:

e Metric version: 64

¢ Inch version: 60

< Font Source
You can set the storage location of
the default font.
* Resident
e RAM
e HDD

e SD

& Note

O Default: Resident

O RAM, HDD and SD can be se-
lected only when fonts have

been downloaded to the ma-
chine.

« Font Number
You can set the ID of the default
font you want to use.

* 0to50by1

& Note
O Default: 0

< Point Size
You can set the point size you want
to use for the selected font.

¢ 4.00 to 999.75 by 0.25

& Note
O Default: 12.00

O This setting is effective only with
variable-space fonts.

e

Font Pitch
You can set the number of charac-
ters per inch for the selected font.

* (.44 t0 99.99 by 0.01
& Note
O Default: 10.00

O This setting is effective only with
fixed-space fonts.

o
<

o
S

*

Symbol Set

You can specify the set of print
characters for the selected font.
The available options are as fol-
lows:

Roman-8, ISO L1, ISO L2, ISO L5,
PC-8, PC-8 D/N, PC-850, PC-852,
PC8-TK, Win L1, Win L2, Win L5,
Desktop, PS Text, VN Intl, VN US,
MS Publ, Math-8, PS Math, VN

Math, Pifont, Legal, ISO 4, ISO 6,
I1SO 11, ISO 15, ISO 17, ISO 21, ISO
60, ISO 69, Win 3.0

& Note
O Default: PC-8

% Courier Font
You can select a courier font type.

* Regular
¢ Dark

& Note
O Default: Regular
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< Extend A4 Width

You can extend the printing area
width (when printing on A4 sheet
with PCL).

o Off
e On
& Note

O Default: Off

O When the setting is On, the width
will be 8 1/, inches.

< Append CR to LF

0
o

When set to On, a carriage return
will follow each line feed: CR=CR,
LF=CR-LF, FF=CR-FF.

o Off
e On

& Note
O Default: Off

Resolution
You can set the print resolution in
dots per inch.

e 300 dpi
* 600 dpi (Fast)
* 600 dpi (Standard)

& Note
O Default: 600 dpi (Fast)

PS Menu

This menu appears only when the op-
tional PostScript 3 unit is installed.

«» Data Format
You can select a data format.

¢ Binary Data
¢ TBCP

? Limitation
O This setting is not effective when
operating the machine with a
parallel, USB, or EtherTalk con-
nection.
O When operating the machine
with a parallel or USB connec-
tion, if binary data is sent from
the printer driver, the print job
is canceled.
O When operating the machine
with an Ethernet connection,
the print job is canceled under
the following conditions;
¢ The printer driver data for-
mat is TBCP, and the data
format selected on the dis-
play panel is Binary Data.

¢ The printer driver data for-
mat is binary, and the data
format selected on the dis-
play panel is TBCP.

& Note
O Default: Binary Data

< Resolution
You can set the print resolution in
dots per inch.

* 600 dpi (Fast)
e 600 dpi (Standard)
* 1200 dpi

& Note
O Default: 600 dpi (Fast)
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< Colour Setting
You can make an RGB setting. PDF Menu

e None

) This menu appears only when the op-
* Fine tional PostScript 3 Unit is installed.

* Super Fine
« Change PDF Password

& Note Set the password for the PDF file
O Default: Super Fine executing PDF Direct Print.

e Current Password

« Colour Profile
You can set the colour profile.
e Auto e Confirm New Password
A password can be set using on the
Web Image Monitor, but in this
* Solid Colour case the password information is
e Photographic sent through the network. If secu-
rity is a priority, set the password
using this menu from the Control

& Note Panel.
O Default: Auto & Note

O Default: Not Set

< PDF Group Password

Set the group password already
specified with DeskTopBinder
Lite.

e Current Password

¢ New Password

¢ Presentation

¢ User Setting

¢ New Password

¢ Confirm New Password

A password can be set using on the
Web Image Monitor, but in this
case the password information is
sent through the network. If secu-
rity is a priority, set the password
using this menu from the Control
Panel.

& Note
O Default: Not Set
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+ Resolution
You can set the print resolution in
dots per inch.

* 600 dpi (Fast)
* 600 dpi (Standard)
e 1200 dpi

& Note
O Default: 600 dpi (Fast)

< Colour Setting
You can make an RGB setting.

¢ None
¢ Fine
¢ Super Fine

E & Note
O Default: Super Fine

% Colour Profile
You can set the colour profile.

e Auto

® Presentation

¢ Solid Colour
¢ Photographic
e User Setting

& Note
O Default: Auto
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6. Using the Document Server

Accessing the Document Server

The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print as and when you want.

? Limitation
O Applications with their own drivers, such as PageMaker, do not support this
function.

/O Reference

For more information about Document Server functions, see General Settings
Guide.

For information about how to access Document Server from a client, see the
printer driver Help.

& Note

O When you use the Document Server, the following functions can be selected
using the machine's control panel:

¢ Copies

¢ Collate

* Duplex

* Staple

e Punch

* Paper selection: Paper source tray, paper type, paper output tray.
* Functions related to paper selection: Cover Sheet, Slip Sheet.

O The above items are dimmed, so you cannot set them from the printer prop-
erties dialog box when the Document Server is selected.

O You must enter a user ID, using up to eight alphanumeric characters.
You should enter a Password and File Name to distinguish the job from others.

Q

O Up to 2,000 files can be stored in the Document Server. No new files can be
stored after 2,000 is reached. Even if less than 2,000 files are stored, new files
cannot be stored when

* a file to be stored contains more than 1,000 pages,

¢ the total number of pages contained in files stored exceeds 9,000,
e the hard disk is full.

O The Document Server also stores files scanned using the Automatic Docu-
ment Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For how
to delete stored files, see General Settings Guide.

O When using the hard disk for functions other than those of Document Server,
you may be unable to store new files in the Document Server, even if there are

less than 2,000 files stored. 123



Using the Document Server

124



S
/. The Functions and Settings
of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

/O Reference

For details about functions and setting items, see Network Guide, PostScript 3
Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:
* Copy

* Printer

¢ Scanner

¢ Fax

e Document Server

& Note

O The machine must be equipped with the Printer /Scanner Unit in order to use
the printer or scanner function.

Interface

The following interfaces are available with the machine:
* Ethernet (100BASE-TX / 10BASE-T)

e USB(2.0/ 1.1

 IEEE 1284 (parallel)

» IEEE 1394 (SCSI print)

e [EEE 802.11b (wireless LAN)

¢ Bluetooth

& Note

O To use the IEEE 1284, IEEE 1394 (SCSI print), IEEE 802.11b (wireless LAN), or
Bluetooth interface, the machine must be equipped with the corresponding
unit for that interface.

O You cannot have the IEEE 1284, IEEE 1394 (SCSI print), IEEE 802.11b (wireless
LAN), and Bluetooth interface on the machine at the same time.
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List of the Setting Items

Web Image Monitor

The following are the items of Web Image Monitor available with the machine:

R:Read
W : Write
—: None

& Note

O Depending on the security settings, certain items may not be displayed.

Menu Before login After login as
Admin.
Top Page R R
Reset Printer Job — RW
Reset Device — RW
Status Input Tray R R
Output Tray R R
Toner R R
Function R R
System R R
Counter R R
Printer Language R R
Document Server RW RW
Fax Received File RW —
Job Printer Job History R R
Error Log RwW RW
Locked & Sample Print | RW RW
Fax History Transmission R R
Reception R R
LAN-Fax R R
Document Server RW RW
Address Book — RW
Inquiry R R




List of the Setting Items

Menu Before login After login as
Admin.
Configuration | Device Settings | System R RW

Paper R RW
Timer Settings R RW
E-mail R RW
File Transfer — RW
Program/Change Ad- | — RW
ministrator
User Authentication |— RW
Management
Administrator Authen- | — RW
tication Management

Printer R RW

Fax General — RW
Administrator Tools | — RW
E-mail Settings — RW
IP-Fax Settings — RW
Gateway Settings — RW
Parameter Settings — RW

Interface R R

Network Protocol R RW
TCP/IP R RW
NetWare R RW
AppleTalk R RW
SMB R RwW
SNMP — RW
SNMPv3 — RW
Rendezvous R RW
System Log R R

Webpage RW RW

Security Access Control — RW
IPP Authentication — RW
SSL/TLS — RW
Certificates — RW
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telnet

The following telnet can be used with the machine:

access, appletalk, autonet, btconfig, dhcp, diprint, dns, domainname, help, host-
name, ifconfig, info, ipp, netware, passwd, prnlog, rendezvous, route, set, show,
slp, smb, snmp, spoolsw, sprint, status, syslog, web, wiconfig, wins

UNIX

The following UNIX commands can be used with the machine:

Device Option Value Function Summary.
binding longedge, shortedge, left, top, Specifies the binding direction for
right duplex printing.
copies Number of copies (1 - 999) Specifies the number of copies.
duplex off, on Specifies whether duplex printing
is on or off.
filetype pcl, postscript (rps) Specifies the printer language for
printing.
filter text Specifies the text printing.
mediatype plain, recycled, special, thick, Specifies the paper type.
transparency, color, letterhead,
preprinted, labels,
plainduplexbacks,
thickduplexbacks,
plainorrecycled
orientation portrait, landscape Specifies the feed direction of the
paper.
outbin lower, finishershift, finisherproof, | Specifies the output tray.
finisherbooklet, upper, lower2,
lower3
paper a3, a4, a5, ab, jisb4, jisb5, jisb6, Specifies the paper size.
ledger, legal, letter, halfletter,
executive, fgl, foolscap, folio,
com10, monarch, c6, c5, dl, k8,
k16, a3wide, custom
punch off, leftport, leftland, rightport, Specifies the punch position.
rightland, topport, topland
punchhole jp2, us2, us3, eu4, neu4 Specifies the punch hole.
qty Number of collated sets (1 -999) | Specifies the number to collate.
resolution value of resolution (300, 600, 1200) | Specifies the resolution for printing.
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Device Option

Value

Function Summary.

staple

off, lefttop, righttop,

Specifies the staple position.

lefttopslantport, lefttopslantland,
lefttopvertport, lefttopvertland,
left2port, left2land, right2port,
right2land, righttopvertport,
righttopvertland, righttopslantport,
righttopslantland,
righttophorizport,
righttophorizland, top2port,
top2land, lefttophorizport,
lefttophorizland, booklet

tray trayl, tray2, tray3, tray4, Ict,

bypass, all

Specifies the input tray.

Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

Settings Selectable Items

Black Over Print Off, On

CMYK Simulation Profile: Off, US OffsetPrint, Euroscale, JapanColor, Palette Color

Collate Off, On

Color/ Black and White Color, Black and White

Color Profile Auto, User Setting, Photographic, Presentation, Solid Color,
CLP Simulation

Color Setting: Off, Fine, Super Fine

Dithering Auto, User Setting, Text, Photographic

Duplex Off, Open to Left, Open to Top

Fit to Print Size: Prompt User, Nearest Size and Scale, Nearest Size and Crop

Gradation Fast, Standard

Gray Reproduction Black by K, Black/Gray by K, CMY + K

Image Smoothing Off, On, Auto, Less than 90 ppi, Less than 150 ppi,

Less than 200 ppi, Less than 300 ppi

Input Tray Bypass Tray, Tray 1, Tray 2, Tray 3, Tray 4

Paper Size See General Setting Guide.

Paper Type See General Setting Guide.

Punch Off, 2 at Left, 3 at Left, 4 at Left, 2 at Right, 3 at Right, 4 at Right,
2atTop, 3 at Top, 4 at Top, 2 at Bottom, 3 at Bottom, 4 at Bottom

Resolution 600 dpi, 1200 dpi

Staple Off, Top Left, Top Right, 2 at Left, 2 at Right, 2 at Top,

2 at Bottom, Bottom Left, Bottom Right
Off, On

Toner Saver
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8. Appendix

Software and Utilities Included on the CD-ROM

Three CD-ROMs come with this printer: "Printer Drivers and Ultilities", "Operat-
ing Instructions”, and "Scanner Driver and Document Management Utility". The
following are included on the three separate CD-ROMs.

< Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled "Printer Drivers and Utilities".

« SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

pe Reference
SmartDeviceMonitor for Admin Help

< SmartDeviceMonitor for Client
For users to manage their network print status.

pe Reference
SmartDeviceMonitor for Client Help

< 1394 Utility
For the optional IEEE 1394 interface unit. For details, see the Readme file or
the manual provided with the optional IEEE 1394 interface unit.

< USB Printing Support
For connection to Windows 98 SE/Me computers via USB.

% Acrobat Reader
This utility allows you to read PDF files (Portable Document Format).

& Note

O Documentation about using the machine is included on the CD-ROM in
PDF format. For details about using Acrobat Reader, see Acrobat Reader
online Help.

<« Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
manage printers. For details about this utility, see PostScript Supplement.
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Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

l] Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B cick [Browse This CD-ROM.
Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system.
The following drivers are included on the CD-ROM provided with this machine.

Printer Language PCL 6 PCL 5¢ RPCS PostScript 3
Windows 95 OK OK OK OK ™2
Windows 98 2 OK OK OK OK ™2
Windows Me ™ OK OK OK OK "2
Windows 2000 ™ OK OK OK OK 13
Windows XP ™ OK OK OK OK 13
Windows Server 2003 " OK OK OK OK *13
Windows NT 4.0 7 oK™ OK *10 OK *10 OK 11 *12
Mac OS " — — — OK "2
Mac OS X — — — OK "4

Microsoft Windows 95 operating system
Microsoft Windows 98 operating system
Microsoft Windows Millennium Edition
" Microsoft Windows 2000 Advanced Server
Microsoft Windows 2000 Server
Microsoft Windows 2000 Professional
Microsoft Windows XP Professional
Microsoft Windows XP Home Edition
6 Microsoft Windows Server 2003 Standard Edition
Microsoft Windows Server 2003 Enterprise Edition
Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.
8 Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)
" Mac OS X 10.1 or later (Native mode)
Requires Service Pack 4 or later.
Requires Service Pack 6 or later.
The Adobe PostScript 3 printer drivers and PostScript Printer Description (PPD) files
are included on the CD-ROM labeled “Printer Drivers and Utilities”.
The PostScript Printer Description (PPD) files are included on the CD-ROM labeled
“Printer Drivers and Utilities”.
14 The Adobe PostScript Printer Description (PPD) installer is included on the CD-
132 ROM labeled “Printer Drivers and Utilities”.
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Software and Utilities Included on the CD-ROM

< PCL printer drivers
Two kinds of PCL printer driver (PCL 5c and PCL 6) are included on the CD-
ROM that comes with this machine. These drivers allow your computer to
communicate with this machine via a printer language.

& Note

O Some applications may require installation of the PCL 5c printer driver. In
this case, you can install PCL 5¢c without having to install PCL 6.

A Reference
See p.19 “Preparing the Machine”.

< RPCS printer driver

This printer driver allows the computer to communicate with the printer us-
ing a printer language. In addition to the conventional user interface, another
preset user interface is provided.

A Reference
See p.19 “Preparing the Machine”.

< Adobe PostScript Printer Drivers and PPD files
Adobe PostScript printer drivers and the PPD files are included on the CD-
ROM provided with this machine. Adobe PostScript printer drivers allow the
computer to communicate with the printer using a printer language. PPD
files allow the printer driver to enable specific printer functions.

AP Reference
See PostScript 3 Supplement.

< PPD files
PPD files are included on the CD-ROM provided with this machine. PPD files
allow the printer driver to enable specific printer functions.

A Reference
See PostScript 3 Supplement.

133



Appendix

SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and
IPX/SPX to monitor network printers. It can monitor multiple network printers
using IP address. We recommend that network administrators use this applica-

tion

< File path

SmartDeviceMonitor for Admin is stored in the following folder on the CD-

ROM.

NETWORK\DEVMON\ADMIN\Disk1l

Operating system

Protocol stack

Windows 95/98/Me

TCP/IP provided with Windows 95/98 /Me
IPX/SPX provided with Windows 95/98/Me
NetWare Client provided with Windows 95/98
Novell Client provided with Windows 95/98

Windows 2000

TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000
Novell Client provided with Windows 2000 or Window NT

Windows XP

TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
NetWare Client provided with Windows XP
Novell Client provided with Windows XP

Windows Server 2003

TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
NetWare Client provided with Windows Server 2003
Novell Client provided with Windows Server 2003

Windows NT 4.0

TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT
Novell Client provided with Windows 2000 or Windows NT

<« Available functions

SmartDeviceMonitor for Admin has the following functions to check:

* printer supplies such as paper or toner;

* results of print jobs executed from the computer.

/O Reference

For information about the operations of the system administrator, see Net-

work Guide.

For information about using SmartDeviceMonitor for Admin, see Smart-
DeviceMonitor for Admin Help.
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.

¢ Printing in a peer-to-peer network, using TCP/IP, NetBEUI, and IPP from
Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.

¢ Constantly monitoring the status of devices on the network using TCP/IP
and IPX/SPX.

< File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-
ROM.

NETWORK\DEVMON\CLIENT\Diskl

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me
IPX/SPX provided with Windows 95/98/Me
NetBEUI provided with Windows 95/98/Me
NetWare Client provided with Windows 95/98/Me
Novell Client provided with Windows 95/98 /Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetBEUI provided with Windows 2000

NetWare Client provided with Windows 2000
Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
NetWare Client provided with Windows XP
Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
NetWare Client provided with Windows Server 2003
Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

NetBEUI provided with Windows NT

Client Service for NetWare provided with Windows NT
Novell Client provided with Windows 2000 or Windows NT
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< Available functions
SmartDeviceMonitor for Client has the following functions.

* Peer-to-peer print function

¢ Prints directly on the network printer without sending any data to a
print server.

¢ Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery
Printing).

¢ Allocates multiple print jobs to multiple printers (Parallel Printing).

* Executes prior group registration of printers specified for Recovery
Printing or Parallel Printing.

¢ Notification function

¢ Displays an error message when there is an error on the specified print-
er while transferring or printing data.

* Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

* Monitoring function
¢ Checks printer supplies such as paper or toner.
¢ Simultaneously monitors multiple printers in use.
* Checks the printer's network settings and detailed information of printers.
¢ Enables you to check the print job log using the user ID
? Limitation
O For Recovery Printing or Parallel Printing, the options on the printers must

be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

O For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same paper
in that tray in all printers.

O For Recovery Printing or Parallel Printing, the print results may be differ-
ent if the printers are not the same model or have exactly the same options.

O If you select Sample Print or Locked Print, you cannot select Recovery
Printing or Parallel Printing.

A Reference
SmartDeviceMonitor for Client Help
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Troubleshooting

Troubleshooting

Error & Status Messages on the Display Panel

This section describes the principal messages that appear on the panel display.

If a message not described here appears, act according to the message.

p Reference

Before turning the main power off, see "Turning On the Power", General Set-

tings Guide.

< Status messages

Message Status

Hex Dump Mode In Hex Dump mode, the machine receives data in hexadecimal
format. Turn off the machine after printing, and then turn back on.

Offline The machine is offline. To start printing, switch the machine

online by pressing [Online] on the display panel.

Please wait.

The machine is preparing the development unit. Wait a while.

Printing... The machine is printing. Wait a while.

Ready This is the default ready message. The machine is ready for
use. No action is required.

Resetting job... The machine is resetting the print job. Wait until “Ready” ap-
pears on the display panel.

Setting change... The machine is setting changing. Wait a while.

Waiting... The machine is waiting for the next data to print. Wait a while.

< Alert messages

Messages/Second messages

Causes

Solutions

Authentication has failed.

The login user name or pass-
word entered is incorrect.
The machine currently cannot
perform authentication.

Check your login user name
and password.

Consult an administrator.

Cannot store data of this size.

The maximum size of files
stored in the document sever
has been exceeded.

Reduce the size of the file you
want to download.

Collate has been cancelled.

The collate print function has
been canceled.

Turn off the main power
switch, and back on again. If
the message appears again,
contact your sales or service
representative.
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Messages/Second messages

Causes

Solutions

Data storage error.

Sample print, locked print, or
accessing the document server
was attempted without the
hard disk installed, or the hard
disk is damaged.

Contact your sales or service
representative.

Driver Setting Error (Memory)

There is an error in the down-
loaded font(s).

Reset the parameter for down-
loading fonts.

Insufficient memory or memo-
ry settings for the printer driv-
er may not match memory
actually installed.

Specify correct memory capac-
ity on the [Change Accesso-
ries...] tab in the RPCS printer
driver.

To print the image correctly,
increase memory capacity, or
reduce resolution image.

Duplex has been cancelled.

Duplex printing has been can-
celed.

Check the paper used is suita-
ble for duplex printing. Or, in-
crease memory capacity.
When installing a memory
module in the machine, con-
tact your sales or service rep-
resentative.

Ethernetboard has a problem.

An error has occurred in the
Ethernet board.

Turn off the main power
switch, and back on again. If
the message appears again,
contact your sales or service
representative.

Exceeded max. capacity of
document server. Cannot
store.

Hard disk drive capacity ex-
ceeded storing to the Docu-
ment Server.

Delete some files stored in the
Document Server or decrease
the file size to be downloaded.

Exceeded max. capacity of
system file. Cannot print PDF
file(s).

File system capacity is full,
and the PDF file cannot be
printed.

Delete unnecessary files from
the hard disk.

Exceeded max. number of
files of document server. Can-
not store.

The maximum number of files
stored in the Document Server
has been exceeded.

Delete some files stored in the
Document Server.

Exceeded max. number of
pages of document server.
Cannot store.

The maximum number of pag-
es stored in the Document
Server has been exceeded.

Delete some pages stored in
the Document Server or de-
crease the number of pages to
be downloaded.

Exceeded max. pages. Collate
is incomplete.

The maximum number of pag-
es has been exceeded for colla-
tion.

Turn off the main power
switch, and back on again. Re-
duce the number of pages to
be printed. If the message ap-
pears again, contact your sales
or service representative.
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Messages/Second messages

Causes

Solutions

Exceeded max. stored files in
sample print and locked
print.

The maximum number of
stored files has been exceeded
during Sample Print or
Locked Print.

Delete some stored files or re-
duce file sizes.

Exceeded max. stored pages
in sample print and locked
print.

The maximum number of
stored pages has been exceed-
ed during Sample Print or
Locked Print.

Reduce the number of pages
to be printed.

File system error. Cannot

The PDF file cannot be printed

Check the PDF file for errors.

print PDF file(s). due to file system error.

HDD is full. The maximum hard disk area | Delete unused form / font
size for form/font has been ex- | types.
ceeded.
An HDD overflow error oc- Delete some stored files, or re-
curred during Sample Print or | duce the size of the file to be
Locked Print. downloaded.

HDD has a problem. An error has occurred in the | Turn off the main power

hard disk drive.

IEEE 1394 board has a problem.

An error occurred in the IEEE
1394 board

switch, and back on again. If
the message appears again,
contact your sales or service
representative.

IEEE 802.11b (Wireless LAN)
has a problem.

IEEE 802.11b interface unit
was not inserted when the ma-
chine was turned on, or it was
pulled out after the machine
turned on.

Turn off the machine and
check the IEEE 802.11b inter-
face unit is inserted correctly.
Then, turn the machine on
again. If the message appears
again, call your service center.

Output tray has been
changed.

The output tray has been
changed because of the paper
size limitation of the selected
tray.

Select the correct output tray.

Paper in staple tray. Open
Finisher Cover and remove

paper.

There is paper remaining in-
side the finisher.

Open the cover of the finisher,
and remove the paper.

Parallel I/Fboard has a problem.

An error has occurred in the
parallel interface board.

Contact your sales or service
representative.

PDF file error. Cannot print.

The PDF file cannot be printed
due to syntax error.

Check the PDF file for errors.

PDF file printing is not al-
lowed. Cannot print.

An attempt was made to print
a restricted document.

The PDF file cannot be printed.

PDF password is incorrect.
Cannot print.

The entered password does
not match that set for printing
encrypted documents.

Enter the correct password.
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Messages/Second messages

Causes

Solutions

Print overrun.

The image data has been
thinned out due to image com-
pression.

Increase memory capacity.
When installing a memory
module in the machine, con-
tact your sales or service rep-
resentative.

Punch has been cancelled.

Punch has been canceled.

Check the paper feed direc-
tion, paper orientation, and
punch position.

Staple has been cancelled.

Staple printing has been can-
celed.

Check the paper feed direc-
tion, paper orientation and
stapling position.

The print job has been can-
celled because capture file(s)
could notbe stored: Exceeded
max. memory.

An HDD overflow error has
occurred when storing cap-
ture file(s).

Delete some files stored in the
Document Server or reduce
the size of files to be printed.

The print job has been can-
celled because capture file(s)
could notbe stored: Exceeded
max. number of files.

The maximum number of
stored capture files has been
exceeded.

Delete some files stored in the
Document Server.

The print job has been can-
celled because capture file(s)
could notbe stored: Exceeded
max. number of pages per
file.

The maximum number of
stored capture pages has been
exceeded.

Delete some files stored in the
Document Server or reduce
the size of files to be printed.

LY Toner is almost empty.

The toner has almost run out.

Replace the toner cartridge
with a new one.

Turn the main power switch
off then on.

The IEEE 802.11b interface
unit may have come off, or an
error may have occurred in the
IEEE 802.11b interface unit.

Turn off the main power
switch, and check the IEEE
802.11b interface unit is in-
stalled correctly. If the mes-
sage appears again, contact
your sales or service repre-
sentative.

USB has a problem.

An error has occurred in the
USB interface.

Turn off the main power
switch, and back on again. If
the message appears again,
contact your sales or service
representative.

You donothave a privilege to
use this function. This job has
been cancelled.

Print job canceled due to user
restrictions.

The login user name or pass-
word entered is incorrect.
The right to use the function
has not been set.

Check your login user name
and password.

Consult an administrator.

You do nothave a privilege to
use this function. This opera-
tion has been cancelled.

The right to use this function
has not been set.

Consult an administrator.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

? Limitation

O The latest 30 error files are stored in the error log. If a new error file is added
when there are 30 error files already stored, the oldest file is deleted. Howev-
er, if the oldest error file is a sample print file or a locked print file, it is not
deleted, but stored instead in a corresponding print error log until the
number of those print error files reaches 20.

O If the main power switch is turned off, the log is deleted.
B press the [Printer] key to display the Printer screen.
ﬂ Press [Error Log].

P b Lits & EmrLog

[tz samprrmimia] |

An error log list appears.
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The Machine Does Not Print

Possible Cause

Solutions

Is the power on?

Check the cable is securely plugged into the power outlet and the
machine.

Turn on the main power switch.

Is the machine online?

If not, press [ I* Online] on the display panel.

Does the printer function
status indicator stay red?

If so, check the error message on the display panel and take re-
quired action.

Is there a warning status or
error message on the dis-
play panel?

If so, check the error message or warning status on the display
panel and take the required action.

Can you print a configura-
tion page?

If you cannot print a configuration page, there maybe a machine
malfunction. Contact your sales or service representative.

See p.113 “Printing the configuration page” for printing a config-
uration page.

Is the interface cable con-
nected securely to the ma-
chine and computer?

Connect the interface cable securely. If it has a fastener, fasten that
securely as well.

See p.11 “Connecting the Machine”.

Are you using the correct
interface cable?

The type of interface cable you should use depends on the compu-
ter. Be sure to use the correct one. If the cable is damaged or worn,
replace it.

See p.11 “Connecting the Machine”.

Was the interface cable
connected after the ma-
chine was turned on?

Connect the interface cable before turning on the machine.

Is the signal status satisfac-
tory when using wireless
LAN in infrastructure
mode ?

To check signal status, press [User Tools/Counter] key on the dis-
play panel, and then press [System Settings] on the display panel.
On the [Interface Settings] tab, select [IEEE 802.11b], and then press
[Wireless LAN Signal]. If signal quality is poor, move the machine to
a location where radio waves can pass or remove objects that
might cause interference.

& Note

O You can check signal status only when using wireless LAN in
infrastructure mode.

When using wireless LAN,
is the SSID correctly set?

Check using the machine's display panel that the SSID is correctly set.

See “Interface Settings/IEEE 802.11b (Option)”, General Settings
Guide.
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Possible Cause

Solutions

When using wirelessLAN, is
the access point correctly set?

Check access point settings when in infrastructure mode. Depending
on the access point, client access may be limited by MAC address.
Also, check there are no problems in transmission between access
point and wired clients, and between access point and wireless clients.

When using wireless LAN,
is the LED on the wireless
LAN card lit or blinking?

Confirm the orange LED is lit, and the green LED is lit or blinks
during transmission.

Is the wireless LAN being
used in ad hoc mode?

Turn the main power off and back on. See “Turning On the Pow-
er”, General Settings Guide.

Otherwise, configure [Network] in [Interface Settings] in [System Set-
tings]. See “Setting Up the Machine on a Network”, Network Guide.

Did you change the option
settings on the machine?

When using the RPCS printer driver on Windows 2000 and con-
necting with IEEE 1394, an error may occur if you change the op-
tion settings on the machine. In this case, follow the procedure
below:

@ Unplug the IEEE 1394 interface cables connected to the computer.
@ Run the utility tool for the IEEE 1394 interface board, which is
stored in the following path on the CD-ROM “Printer Drivers
and Utilities”.
\UTILITY\1394\

AP Reference
For more information about using the utility tool for IEEE
1394, see the README file in the same directory on the CD-
ROM.
® Restart the computer.

@ Connect the computer to the machine using the IEEE 1394 in-
terface cables.

Is the weekly timer set?

The printer may not be able to print because of the weekly timer
setting. Check the setting. For details, see “User Tools (System Set-
tings)”, General Settings Guide.

Print cannot be performed
from the printer driver.

The login user name, password, or driver encryption key entered
is incorrect.

A high level of encryption was set using the Extended Security
function.

®  Check your login user name, password, and driver encryption key.

* For information about the Extended Security settings, consult
an administrator.
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Problem

Solutions

Is the Data In indicator
blinking or lit after starting
the print job?

If not, data is not being sent to the machine.

< When the machine is connected to the computer using
the interface cable

Check the machine port settings are correct. For parallel port
connection, port LPT1 or LPT2 should be set.

Windows 95/98/Me

@ Click the [Start] button, point to [Settings], and then click
[Printers].

@ Click the icon of the machine. On the [File] menu, click
[Properties].

® Click the [Details] tab.

@ In the [Print to the following port:] list, confirm the correct
port is selected.

Windows 2000

@ Click the [Start] button, point to [Settings], and then click
[Printers].

@ Click the icon of the machine. On the [File] menu, click
[Properties].

® Click the [Ports] tab.

@ In the [Printto the following port(s)] list, confirm the correct
port is selected.

Windows XP Professional, Windows Server 2003

@ Click the [Start] button, and then click [Printers and Faxes].

@ Click the icon of the machine. On the [File] menu, click
[Properties].

® Click the [Ports] tab.

@ In the [Printto the following port(s)] list, confirm the correct
port is selected.

Windows XP Home Edition

@ Click the [Start] button, click [Control Panel], click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

@ Click the icon of the machine. On the [File] menu, click
[Properties].

® Click the [Ports] tab.

@ In the [Print to the following port(s)] list, confirm the correct
port is selected.

Windows NT 4.0

@ Click the [Start] button, point to [Settings], and then click
[Printers].

@ Click the icon of the machine. On the [File] menu, click
[Properties].

® Click the [Ports] tab.

@ In the [Printto the following port(s)] list, confirm the correct
port is selected.

% Network connection
Contact your network administrator.




Troubleshooting

Other Printing Problems

Problem Causes and Solutions
The print on the en- | If the [Toner Saving] check box is selected in the printer driver settings, the
tire page is faded. | entire page will be faded when printed.

For the RPCS printer driver, [Toner Saving] is located on the [Print Quality]
tab. For the PostScript 3 printer driver, see PostScript 3 Supplement.

See the printer driver Help.

Print is smudges.

Settings for thick paper have not been made when printing on thick paper
in the bypass tray.
e PCL 6/5c and PostScript 3
Select [Thick] in the [Type:] list on the [Paper] tab.
e RPCS
Select [Thick] in the [Paper Type:] list on the [Print Settings] tab.

When printing
graphics, the out-
putand the screen
are different.

If the printer driver is configured to use the graphics command, the graph-
ics command from the machine is used to print.

If you want to print accurately, set the printer driver to print without using
the graphics command.

See the printer driver Help.

Page layout is not
as expected.

Print areas differ depending on machine used. Information that fits on a sin-
gle page on one machine may not fit on a single page of another machine.

Adjust the [Printable area:] setting in the [Printer Configuration...] dialog box
on the [Print Settings] tab in the RPCS printer driver.

See the printer driver Help.

Duplex printing is
malfunctioning.

¢ Duplex printing cannot be done with paper set in the bypass tray.
When using duplex printing, make settings to use paper from a tray
other than the bypass tray.

* Duplex printing cannot be done with thick paper, OHP transparencies,
or labels specified as the paper type. Specify another paper type.

¢ Duplex printing cannot be done with a tray for which [1 Sided Copy] has
been specified as Paper Type on the System Settings menu. Change the
Paper Type setting for the tray to [2 Sided Copy] on the System Settings
menu. See General Settings Guide.
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4.0, either com-
bined printing or
booklet print does
not come out as
expected.

When using Win-
dows 95/98/Me/
2000/XP, Win-
dows Server 2003,
or Windows NT
4.0, Auto Re-
duce/Enlarge
print does not
come out as ex-
pected.

Problem Causes and Solutions
When using Win- | Make sure the application's paper size and orientation settings match those
dows 95/98/Me/ | of the printer driver.
2000/XP, Win- If a different paper size and orientation are set, select the same size and ori-
dows Server 2003, | ontation.
or Windows NT

A print instruc-
tion was issued
from the compu-
ter, but printing
did not start.

User code management may have been set. Ask the administrator about
valid user codes. To print, the user code must be entered from the printer
driver.

The printjobis not
canceled even
when the machine
is switched to of-
fline status.

Even when the machine is offline, printing is performed when [Job Accept-
ance Priority] has been set in [Parallel Interface] in the [Interface Settings] in the
System Settings menu. Change the setting of Signal Control to Printer pri-
ority.

See “User Tools (System Settings)”, General Settings Guide.

Photo images are
coarse.

Some applications reduce print resolution.

Fine dot pattern
does not print.

Make the following settings with the printer driver:

* Change the [Dithering:] setting on the [Image Adjustments] tab in the
[Change User Settings...] dialog box on the [Print Quality] tab in the RPCS
printer driver.

& Note
O To enable [Change User Settings...], select the [User Setting] check box.
See the printer driver Help.

Images are cut off,

or excess is printed.

You may be using paper smaller than the size selected in the application.
Use the same size paper as that selected in the application. If you cannot
load paper of the correct size, use the reduction function to reduce the im-
age, and then print.

See the printer driver Help.




Troubleshooting

Problem Causes and Solutions
It takes a long Photographs and other data intensive pages take a long time for the ma-
time to completea | chine to process, so simply wait when printing such data.
print job. Changing the following settings with the printer driver may help speed up
printing:
< PCL 6/5¢

Select the lowest value for [Resolution] on the [Print Quality] tab in the
printer properties dialog box.

K2
o

PostScript 3
Set the lower value in [Resolution]. The location of this setting is given
below.
If your operating system is Windows, select [PostScript (optimize for
speed)] in [PostScript Output Option]. [PostScript Output Option] is located as
follows:
e Windows 95/98/Me
[Print Quality] tab in the printer properties dialog box.
e  Windows 2000/ XP, Windows 2003 Server
[Print Quality] in [Graphics] on [Advanced...] on [Paper Quality] tab in the
printer properties dialog box.
e Windows NT 4.0
[Graphics] on [Advanced...] on [Paper Quality] tab in the printer proper-
ties dialog box.
e Mac OS9.x
[Printer Specifications] in the print dialog box.
e MacOSX
[Set 3] tab in [Printer Features] in the print dialog box.
If you use Windows, select [PostScript (optimize for speed)]
e Windows 95/98/Me
[PostScript output format:] on the [PostScript] tab in the printer proper-
ties dialog box.
e  Windows 2000/ XP, Windows Server 2003
[PostScript Output Option] in [PostScript Option] on [Advanced...] on
[Print Quality] tab in the printer properties dialog box.
e Windows NT 4.0
[PostScript Output Option] in [PostScript Option] on [Document Options]
on [Advanced...] tab in the printer properties dialog box.

% RPCS
Select [Speed] for [Print priority] on the [Print Quality] tab in the printer
driver's dialog box.

& Note

O To enable [Change User Settings...], select the [User Setting] check box.
Select [Fast] for [Document type] list on the [Print Quality] tab in the printer
properties dialog box.

K2

See the printer driver Help.
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Problem

Causes and Solutions

It takes a long
time to complete a
print job.

The data is so large or complex that it takes time to process. If the Data In
indicator is blinking, data is being processed. Simply wait until printing
resumes.

If “Warming Up. . .” appears on the display panel, the machine is
warming up. Wait for a while.

It takes too much
time to resume

The data is so large or complex that it takes time to process. If the Data In
indicator is blinking, data is being processed. Simply wait until printing

from the selected
tray.

printing. resumes.
The machine was in Energy Saver Mode. To resume from Energy Saver
Mode, it has to warm up, and this takes time. See General Settings Guide.
Paper is not fed When you are using a Windows operating system, printer driver settings

override those set using the display panel. Set the desired input tray using
the printer driver.

See the printer driver Help.

Solid lines are
printed as broken
lines.

Make the following settings with the printer driver:

* Change the [Dithering:] setting on the [Image Adjustments] tab in the
[Change User Settings...] dialog box, on the [Print Quality] tab in the RPCS
printer driver.

See the printer driver Help.

Optional compo-
nents connected to
the machine are not
recognized when
using Windows
95/98/Me, Win-
dows 2000/ XP,
Windows Server
2003,and Windows
NT 4.0.

You have to configure the option setup in printer properties when bidirec-
tional transmission is not enabled.

See the printer driver Help.

Images are print-
ed in the wrong

The feed orientation you selected and the feed orientation selected in the
printer driver's option setup might not be the same. Set the machine's feed

is different from
the image on the
computer's dis-
play.

orientation. orientation and the printer driver's feed orientation accordingly.
See the printer driver Help.
The printed image | With certain functions, such as enlargement and reduction, image layout

might be different to that on the computer display.

You might have selected to replace True Type fonts with machine fonts in
the printing process.

To print an image similar to that of the computer display, make settings to
print True Type fonts as an image.

See the printer driver Help.




Troubleshooting

Problem

Causes and Solutions

No transmission
when using 1394
interface connec-
tion

Check using the following procedure:
@ Confirm the IEEE 1394 interface cable is connected securely.

@ Restart the computer.
If the error occurs even after executing the above operation, proceed to
the following steps.

® Unplug the IEEE 1394 interface cable connected to the computer.

@ Run the utility tool for the IEEE 1394 interface board, which is stored in
the following path on the CD-ROM “Printer Drivers and Utilities”:
\UTILITY\1394\

AL Reference
For more information about using the utility tool for IEEE 1394, see
the README file in the same directory on the CD-ROM.

® Restart the computer.

When connecting
the machine using
USB 2.0, the first
page of a print job
that contains a
large volume of
data is printed,
but the remaining
pages are not.

Check that USB Printing Support is installed on your computer.

A Reference
See p.43 “Installing the Printer Driver Using USB”.

& Note

O If the problem cannot be solved, contact your sales or service representative.
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System Settings (Parallel Connection)

< Parallel Timing
Specifies the timing for the parallel
interface. Normally, you do not
need to change this setting.

¢ ACK Inside
¢ ACK Outside
e STB Down

& Note
O Default: ACK Inside

< Parallel Communication Speed

Specifies the communication
speed of the parallel interface. If
the speed is too high, data may not
be transferred smoothly. If this
happens, change the setting to
“Standard”.

¢ High Speed

¢ Standard

& Note
O Default: High Speed

< Selection Signal Status
Specifies the signal level of the par-
allel interface.
* High

e Low

& Note
O Default: High

< Input Prime
Specifies whether the prime signal
is active or inactive when an input
prime signal is sent. Normally, you
do not need to change this setting.
* Effective

e Invalid

& Note
O Default: Invalid

*

<« Bidirectional Communication

Specifies, for instance, how a print-
er connected to the parallel inter-
face responds to a status request. If
you experience problems using an-
other manufacturer’s printer, set
this to Off.

? Limitation

O If set to Off, asynchronous com-
munication will not work.

e On
o Off

& Note
O Default: On

Signal Control

Specifies how to handle any errors
that occur when printing from a
computer. Normally, you do not
need to change this setting.

* Job Acceptance Priority

¢ Printer Priority

& Note
O Default: Job Acceptance Priority



Precautions when using Windows Server 2003

Precautions when using Windows Server
2003

Precautions when using the Terminal Server mode

Certain printer driver functions are disabled. Disabled functions are displayed
in gray. When using all printer driver functions, use Windows Server 2003 in

normal mode.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications

Resolution 1800 x 600 dpi equivalent
1200 x 1200 dpi (PCL6, RPCS and PostScript3 only)
600 x 600 dpi

300 x 300 dpi (PCL5c B&W only)

Printing speed Type 1:

e Full Colour: 24 ppm

¢ B&W: 28 ppm

Type 2:

¢ Full Colour: 28 ppm

¢ B&W: 35 ppm

Type 3:

¢ Full Colour: 35 ppm

* B&W: 45 ppm

(A4[J,8'/2" x 11"[) plain paper)

& Note

O Printing speeds depend on the machine. Check which type of
machine you have. See General Settings Guide.

Interface Standard:

e Ethernet interface (100BASE-TX / 10BASE-T)
e USB 2.0 interface

Option:

* IEEE 1284 parallel interface

& Note

O Use astandard 36-pin printer cable not longer than 3 meters
(10 feet).

¢ IEEE 1394 interface
¢ IEEE 802.11b wireless LAN interface

¢ Bluetooth interface

Network protocol TCP/IP, IPX/SPX, NetBEUI ", AppleTalk
Printer language Standard: PCL 6/5¢c, RPCS
Option: PostScript 3, PDF
Fonts PCL6/5c:
Agfa Monotype 35 Intellifonts, 10 TrueType fonts, and 1 Bitmap font.
PostScript 3 :
136 fonts (Type 2:24, Type 14:112)
Memory 1024 MB
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Component Specifications
Hard disk Storage capacity : 80 GB
Operating systems sup- | Windows 95/98/Me
ported by this machine Windows 2000
Windows XP
Windows Server 2003
Windows NT 4.0
Mac OS 8.6 t0 9.2
Mac OS X
Network cable 100BASE-TX / 10BASE-T shielded twisted-pair (STP, Category/ Type5)

cable.

"l To use NetBEUJI, use the SmartDeviceMonitor port.
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Options

? Limitation

O Only one optional interface board can be installed in the machine at a time.
Therefore, the optional IEEE 1394 interface board, the IEEE 802.11b interface
unit, the IEEE 1284 interface board, and Bluetooth interface unit cannot be in-
stalled concurrently.

IEEE 1394 Interface Board Type B

< Transmission spec.:
IEEE 1394

% Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

< Device class:
SCSI print (Windows 2000/ XP, Windows Server 2003)
IP over 1394 (Windows Me/XP, Windows Server 2003)

< Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)

« Interface connector:
IEEE 1394 (6 pin x 2)

< Required cable:
1394 interface cable (6 pin x 4 pin, 6 pin x 6 pin)

ﬂlmportant
O You cannot plug devices together to create loops.

O Do not use cable that is more than 4.5 meters in length.

< Data transfer speed:
Maximum 400 Mbps

« Connectable number of devices on a bus:
Maximum 63

< Allowed cable hops on a bus:
Maximum 16

< Power supply:

Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)
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IEEE 1284 Interface Board Type A

< Transmission spec.:
IEEE 1284

< Required cableed:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

< Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

< Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web browser are supported.

< Data transfer speed:

Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

< Frequency range:

¢ Inch version:
2412 - 2462 MHz (1 - 11 channels)

e Metric version:
2412 - 2472 MHz (1 - 13 channels)

« Transmittable distance:
1 Mbps 400 m !
2Mbps 270 m !
5.5 Mbps 200 m
11 Mbps 140 m ™!
"I These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10 - 100 m, depending on environment.
« Transmission mode:
Ad hoc, and infrastructure mode

PostScript 3 Unit Type 3245

AP Reference
See PostScript 3 Supplement.

Bluetooth Interface Unit Type 3245

/O Reference

See p.54 “Printing with Bluetooth Connection”.
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Bluetooth Interface Unit Type 3245, 155
Bypass tray, 14

(o

Hard disk, 153
Host Interface, 118

Canceling a job
Windows, 107
Clear/Stop key, 6
Collate, 89
Configuration page, 113
Connection
Ethernet interface connection, 13
IEEE 1394 interface connection, 12
Parallel interface connection, 12
USB interface connection, 11
Control Panel, 5
printer features, 109
Control panel
locked print, 86
sample print, 82
Covers, 99
Custom size paper, 16
printing, bypass tray, 14

D

IEEE 1284 Interface Board Type A, 155
IEEE 1394 Interface Board Type B, 154
IEEE 802.11b Interface Unit Type H, 155
Installing the Printer Driver

Quick Install, 19
Installing the Printer Driver Using USB, 43
Interface, 152

L

List / Test Print, 113
Locked print, 86
deleting, 87

M

Data In indicator, 6, 144, 148
Display panel, 5,7

error messages, 137
Document Server, 123

E

Main power indicator, 5
Maintenance, 115
Memory, 152

N

Network Cable, 153
Network protocol, 152
Number keys, 6

(0]

Energy Saver key, 5
Error Log, 141
Error messages, 137

F

Finisher, 91

Font Manager 2000, 61
Fonts, 152

Function keys, 6

Function status indicator, 6

OHP Transparencies
printing, bypass tray, 17

On indicator, 5

Operating system, 153

Operation switch, 5

Options, 154
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PageMaker, 62
PCL menu, 119
PDF Direct Print, 79
PostScript 3 Unit Type 3245, 155
Precautions when using the Terminal
Server mode
Windows Server 2003, 151
Precautions when using Windows Server 2003
Windows Server 2003, 151
printer driver, 132
Printer features
adjusting, 112
menu, 109
parameters, 113
Printer Language, 152
Printing a PDF File Directly
PDF Direct Print, 79
Printing Method
PDF Direct Print, 79
Printing speed, 152
Printing with Bluetooth Connection
Windows, 54
Printing with Parallel Connection
Windows 2000, 48
Punch, 96

R

Resolution, 152

S

Sample print, 82

deleting, 84
Slip Sheet, 103
SmartDeviceMonitor for Admin, 134
SmartDeviceMonitor for Client, 135
Specifications, 152
Spool printing, 98
Staple, 92
System, 115

Thick Paper
printing, bypass tray, 17
Troubleshooting, 137
error messages, 137
machine does not print, 142
other printing problems, 145
status messages, 137

User Tools/Counter key, 5
w

Windows

canceling a job, 107
Windows 2000

printer properties, PCL, 64

printer properties, RPCS, 72
Windows 95/98/Me

printer properties, PCL, 63

printer properties, RPCS, 70
Windows NT 4.0

document defaults, PCL, 68

document defaults, RPCS, 77

printer properties, PCL, 68

printer properties, RPCS, 76
Windows Server 2003

printer properties, PCL, 66

printer properties, RPCS, 74
Windows XP

printer properties, PCL, 66

printer properties, RPCS, 74
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Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and its amending di-
rectives and the Low Voltage Directive 73/23/EEC and its amending directives.”

Caution:

Network interface cables with ferrite core must be used for RF interference suppression.

Copyright © 2004
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